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1 Overview

1.1 Introduction

Kompass FX3 is a professional multimedia playback software. Together with the video or image
processing devices, it allows for professional management for LED screen playback. Featuring a

simplified and friendly user interface, Kompass FX3 makes operations as simple as possible.

Kompass FX3 takes full advantage of the hardware decoding and rendering technologies of the
professional graphics card, realizing smooth playback of multiple 4K videos of different formats.
In addition, separated live and pre-edit modes greatly enhance the convenience and safety of
video playback and control management. Kompass FX3 supports multi-layer and multi-
program management, fade transition effect, quick picture rotation, and dynamic playback of
PowerPoint files, thus undoubtedly becoming the ideal choice for a variety of fixed installation

applications such as multimedia exhibition halls, conference rooms, data centers and more.

1.2 Features

® Simultaneous playback of 12x mixing layers and 1x audio
® Visualized program arrangement and management
® Live and pre-edit modes
- The program editing and playback are in sync in live mode
- Edit the programs before displaying them on the screen in pre-edit mode
® Media library management, including videos, pictures, PowerPoint files and audios
® Media file sorting
® Media file batch import

® NDI sources, website page sources, sources from capture devices, streaming media sources

and text sources supported
® Media collection configurations
® Custom OSD
® Resolution adjustment of PowerPoint files
® Using a laser pointer for moving between slides in PowerPoint

® Auto presentation of PowerPoint file when the program starts to play
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Playback of subtitled videos

® Playback progress management

® Shortcut key for program jumping and auto jumping settings
® Configurable layer size and priority

® Main KV jumping settings

® Main media based playback progress management

® Crossfade on program switching

® | ayer mask, cropping, keying, blurring and opacity adjustment
® Inheritance of audio properties supported

The audio properties remain unchanged when you replace the layer audio media of the

program
® Auto startup of built-in software on system power on
® Auto program playback on software startup
® Remote control via UDP or TCP/IP
® Controlled by a central control unit
® Auto saving of project file being edited

® Controlled via NovaStar’s Visual Intelligent Control Platform (VICP), enabling a highly

efficient and user-friendly control experience
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2 Software Installation and Activation

2.1 Software Installation

Requirements of Software Operating Environment

® CPU: 9th Generation Intel® Core™ i7 or later
® RAM: 16GB or greater DDR4 2666

® Graphics card: NVIDIA P2200 (or later) or AMD W5100 (or later) discrete graphics card

recommended
® HD space: 512G minimum available

® OS: Windows 10 Enterprise LTSC
Installing Software

The installation procedure is the same as that of other software applications.

Step 1 Double click the program file (*.exe) and follow the instructions to proceed. On the Select

Additional Tasks screen, select Create a desktop shortcut and click Next.

Step 2 Proceed to Ready to Install window and click Install to start the installation. After the
installation process ends, click Finish.

Two application programs are installed during the installation process:
® Kompass FX3: The video playback and control application program

® NDI Sender: The NDI sender end that provides NDI inputs for Kompass FX3

E Note

e It is recommended you turn off the anti-virus software and firewall in advance.

¢ During installation, if the anti-virus software or firewall prevents the installation, choose to
allow the installation.

o If the software prompts you to restart after the installation, it is recommended you restart

the software for normal operation.
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2.2 Software Licensing

Kompass FX3 supports two authorization modes: temporary authorization and permanent
authorization.

® When Kompass FX3 is temporarily authorized, the remaining days of temporary
authorization is displayed at the top right.

® When Kompass FX3 is permanently authorized, no authorization message is displayed at the
top right.

® When Kompass FX3 is not authorized, Trial is displayed at the top right.

If you want to obtain authorization, please contact our sales engineer for purchasing the dongle

or registration code.
In trial mode, the Kompass FX3 is displayed on the output.
Dongle detection rules are as follows:

® When the inserted dongle is recognized, Trial will disappear automatically and the output

will not display the Kompass FX3 .

® Within 3 seconds after the dongle is removed, the software knows the dongle has been
removed and prompts you that no dongles have been detected, and the software will again

display the Kompass FX3 text on the output in 5 seconds.

Figure 2-1 Dongle removed

Thauthorized

Kompass FX3

Please insert dongle or send QR to seller for getting serial.

Serial

0K Cancel

When the dongle is inserted and recognized normally, the above window and the Kompass FX3

text on the output will disappear automatically.
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3 User Interface Introduction

E Note

The software pictures given in this guide are for illustration purposes only. The actual user
interface may vary due to product enhancement. The content of the pictures can be slightly

different from reality such as the media files, form and position of software windows and more.

After the software is started, the main user interface is shown in Figure 3-1. The functions of

each area are described in Table 3-1.

Figure 3-1 User interface

Help  if#/Language

Table 3-1 User interface area descriptions

Area Item Description

Menu bar Project Project file operations include:

® New: Create a new project.

® Open: Open a saved project.

® Save: Save the current project.

® Save As: Save the current project as a new project.

® Package Project: Package the current project file and

all media in it for easy use in the future.

Link ® Link Settings: Set the primary/backup devices and
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Area

Item Description

master/slave devices.

® Update to Backup: Manually update the data on the
primary device to the backup device.

® Update to Slave: Manually update the data on the
master device to the slave device.

® Disconnect: Disconnect the backup/slave device from
the primary/master device.

Settings Settings include system, output, audio, display mode

and external control settings.

Help ® Use the transcoding assistant.
® View and export the playback logs.
® Open the user manual.

® View the software information.

BE/Language Change the software language.

Al Assistant Open Al Assistant to perform Al chat and text-to-image

operations.

Login Log in to VNNOX to access media on it after logging in.

Media library &
Output control

® | ocal Media: Add the desired local media files, including videos, pictures,
PowerPoint files, audios, website pages, streaming media, OSDs and digital

clocks, etc.

Go to Settings > System Settings to set the shared folder path, and then
place the desired media files under this path. Kompass FX3 will automatically
read the files and display them in the Media Library area. When you delete
the media saved in the shared folder, this media will also be deleted in
Kompass FX3.

® Cloud Media: Display media from VNNOX. After downloading, they can be
stored locally. If Cloud Media Path is set under Settings > System Settings,
the downloaded cloud media can be directly placed in this shared folder

path.

® Output Control: Add the commands for controlling the splicers.

Stage editing area

Stage ® Preview the real-time playback content.
® Edit the position and size of the added media.
A Output control buttons

o : Open the output editing window.

v
o : Enable the output screen and display the
playback content on the screen. (Shortcut key:

www.novastar.tech




NOVASTAR Kompass FX3 Multimedia Playback Software User Manual

Area Item Description

Shift+H)

o : Disable the output screen. (Shortcut key:
Shift+H)

TEST

e ™ Close the test pattern and display the playback
content.

=
o : Open and display the test pattern.

o = : Disable the FTB function and display the
playback content.

o ! : Make the output fade to black.

B Individual screen management area
® Click to add a screen.

® Click each screen to view and manage the programs

by screens.

C Two editing modes are provided.

® Live: The playback editing process is displayed on the

output screen in real time.

® Pre-Edit: The playback editing process will not be
displayed on the output screen. After you have

the stage editing area to send the playback content

completed the editing, click at the top right in

to the output screen and play the content from the

beginning.

D Quickly adjust the layers.

® X: Set the initial horizontal coordinate of the layer.
® Y: Set the initial vertical coordinate of the layer.

® Width: Set the width of the layer.

® Height: Set the height of the layer.

Rotate: Set the angle by which the layer rotates

clockwise.

-‘: Bring the selected layer forward.

.: Send the selected layer backward.

|
= Bring the selected layer to front.
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Area

Item

Description

o
e ": Send the selected layer to back.
. 7

: Make the selected layer fill the output area.

o : Configure the rendering mode for the video
played in the stage editing area. The options include
SDR and HDR10.

When HDR10 is selected, the monitor where the
software is installed must support HDR10 and the
HDR playback function is enabled, so that the HDR
effect can be displayed.

E Note

Only 10th Gen Intel GPU or later supports HDR output.

L : Lock the stage editing area.

Pan or zoom the output area.

L : Pan the stage editing area.

: Zoom in or out the stage editing area.

F_"
e L J:Make the stage start at the origin and all layers

locate within the visible range in the stage editing

area.

® Properties: configure the media properties, including
the layer basic info, trim, opacity, color, cropping,

transition effect, graphics card mapping and more.

® Playback: Control and view the playback progress.

L
- G: Count up timer

- F\D: Count down timer
- D: Start the playback.
- @: Pause the playback.

- D: Stop the playback.
- <€) : Adjust the volume.
® Update: View the progress of updating the data to
the backup/slave device.

® Timecode: Set the timecode-based program playback

list for the program control in shows and more

www.novastar.tech
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Area

Item

Description

applications. LTC and MTC both require external
timecode reference devices.

Program

management area

n/50

Indicate the quantities of the edited programs and the

total programs in the current group.

® n: Indicates the quantity of the edited programs or

the programs that have media files.

® 50: Indicates the default quantity of the total
programs. When a new program is added, the value

increases accordingly.

Program n

View the program name.

Layer and layer
status

® | ayer n/audio: Displays the layer name and indicates

whether the layer comes with audio or not.
L “: Turn off the layer audio.

4 n: Play the layer audio.

® [cons on the layer:

- : This icon indicates the layer is the main
media and the timer in the Playback area is

based on this layer.

- : After the playback of the media in the
current layer is completed, the layer stops the
playback and displays the last frame of the
playback image.

—
- : Within the timing period for the main

media, the current layer media is in loop

playback mode.

- @: Within the timing period for the main
media, the audio media playback will be stopped
after it is finished.

- Lock: The layer is locked.

Status bar

——®
° @ : Increase or decrease the

program column width.

. : Enable the PowerPoint file playback mode.
You can use the laser pointer buttons or keyboard

buttons to move between slides.

. : Disable the PowerPoint file playback mode.

www.novastar.tech
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Area Item Description

o : Disable the C3 control.
o “: The C3 control is enabled.
: The scheduled playback is enabled.

: The schedules playback is disabled.

: The paging turning function is enabled, and

the arrows keys on the keyboard can be used to turn
pages.

o : The paging turning function is disabled, and
the arrows keys on the keyboard can be used to
select between programs.

® Display the current CPU and memory usage.

Link status ® Name: The computer name by default

® Backup/Slave: Show the statuses of the backup and
slave devices. These items are shown on the

primary/master end only.
- n: Not set

- .: Disconnected

- .: Normal communication

3.1 Change Layout

The main user interface can be customized according to user preferences. Once adjusted, the
layout is automatically saved. Upon reopening next time, the interface retains the layout as

adjusted last time.

To modify a particular area, hover the mouse cursor over the edge of the area until it changes
into a double-headed arrow. Then, click and hold the left mouse button to drag horizontally to

adjust the width, or vertically to adjust the height of the selected area.

Figure 3-2 Change user interface layout

Nk

il
+
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3.2 Lock User Interface

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Locking the user interface prevents unauthorized access to the editing environment, particularly

when the operator is away.

Click &

at the top right of the main interface to open the Ul locking window.

Figure 3-3 Lock user interface

Lock User Interface

Opacity

tuto Lock |Never

Lock uszer interface on startup

OK Cancel Lock
Enter the password in the text box next to Password.

Clicking Z or ¥ next to Password allows you to show or hide the password.
Adjust the opacity of the lock screen.

An opacity setting of 100% means it is completely opaque, obscuring the editing interface and

showing only the lock screen background.
Define the duration of inactivity after which the system will automatically lock itself.

Options include Never, 3 minutes, 5 minutes, 10 minutes, and 30 minutes, with Never

indicating no automatic screen locking.
Decide whether to lock the user interface upon software launch.

® Select Lock user interface on startup to default to the lock screen when the software starts
up.
® Deselect it to display the main software interface after startup.

Confirm the settings by clicking OK.

By clicking Lock, the system enters to the lock screen mode, and the screen lock settings take
effect.

www.novastar.tech 14
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E Note

e To unlock, enter the previously set password and click to access the software editing
interface.

e If the password is forgotten, please contact our technical support engineer for assistance.

3.3 View System Messages

The system will provide alarms or messages in Message Center under the following conditions:
® Added media exceeds 8192x4320.

® The main display's refresh rate is non-standard, such as 59.94/59.95/60 Hz.

Click Q at the top right corner to open the Message Center interface.
Figure 3-4 Message center

Message Center

@ Warning

- If media resolution is too large, click Set to open the Transcoding and Encryption

Assistant window for transcoding to enable normal playback.

- If the display has a non-standard refresh rate, click Set to enter the Windows system

advanced settings interface.

Clear: Clear all messages.

Read All: Set all messages as read.

Do Not Disturb: Turn the mode on or off.

- On: The system will receive messages but not display notifications.
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- Off: The system will show message alerts.
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4 Applications

Figure 4-1 Applications

LED Screen

Kompass FX3

Monitor Media Server Dongle

www.novastar.tech 17



NOVASTAR Kompass FX3 Multimedia Playback Software User Manual

5 Project

Kompass FX3 allows you to add media files, edit the programs and set the program playback
sequence and media properties. After all these are done, you can save those configuration as an

independent project file to your local storage for future use.

5.1 Create New Projects

There are two methods to create a new project.
® Start Kompass FX3 and the software will create a new project automatically.

® Go to Project > New to create a new project.

5.2 Edit Outputs

Kompass FX3 supports output editing, allowing you to partition the output screen and perform

output connector mosaic, thus realizing a mosaic output of desired connectors and partitions.
Click to open the Edit Output window.

Figure 5-1 Edit output

Edit Qutput

Output 1-1 (SDRG1) Output 2-1

Output 1-1 (SDR,GT)
Output 3-1 Output 4-1

,ﬂ O 100 ® )
ODNMMEHAEEED + @

[Open Identify

) (Cancel) [ Apply )
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5.2.1 Add Outputs

To synchronize output images, please refer to Graphics Card Mosaic to complete relevant

configurations.

Add and bind outputs automatically

After startup, Kompass FX3 will automatically detect the graphics card connectors and then
complete the adding and binding of those detected connectors. All the connectors are

displayed in the output list on the left.
When you need to change the binding relations between the output connectors and screens,

click @ to change the output name, connector binding and resolution.

Add and bind outputs manually

When more graphics cards are installed on the control PC or you want to change the connector

quantity in a saved project file, you can select to add the outputs manually.
Click T inthe output list area to add an output.

Figure 5-2 Add and edit outputs
Modify Output
Main Screen  1,G1(1920x1080)Not Recommended

Name |Qutput 2

Connector | 1,G1(1920x1080,Intel(R) UHD Graphics 770)Not R ~

Resolution W 1920 . H 1080 .

HDR |SDR v

OK Cancel

® Name: Change the current output name.

® Connector: Select the desired output connector from the drop-down list or change the

connector binding relation. Here take Figure 5-2 as an example to illustrate.

- 1: Connector number of the graphics card (1 indicates the connector 1 of the graphics

card.)
- G1: Graphics card 1

- 1920%1080: Output resolution of the current connector of the graphics card
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- Intel(R) UHD Graphics 770: The graphics card name of the current device
® Resolution: Set the desired output width and height.

® HDR: Configure the output format for the video. The options include SDR and HDR10. When
SDR is configured, the video will be output in SDR format.

E Note

Before you configure HDR, go to Settings > Output Settings to enable HDR.

5.2.2 Configure Regular Screens

Step 1 Click to open the Edit Output window.

Step 2 Organize the output connectors on the right via drag and drop operations to suit the loaded

screen.

Figure 5-3 Connector layout

Edit Qutput

Output 1-1 (SDRG1) Output 2-1

Output 3-1 Output 4-1

Qutput 4-1

¥ 0w @ 3
ONMMEBEEES + &

X Y w H

[Open Idenlify\

Step 3 Click OK to complete the editing.

E Note

In the output editing area, click and drag to select multiple outputs to adjust them

simultaneously.
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5.2.3 Construct Irregular Screens

When you want to output an image of an irregular shape, you can partition the output and
reorganize the sub-outputs to suit the loaded screen.

Output Partitioning

This function divides an output into several sub-outputs, breaks up and reorganizes the

outputs, realizing easy reconstructing and management for irregular output images.

You can realize the output of an irregular image via the reorganizing of regular output

connectors.

Figure 5-4 T-shape output image

Step 1 Select a partition layout in the output list area.
Figure 5-5 Output partitioning

¥ Output 1 (1920*

Cutput 1-4

¥ Ox
ONDMEHHEEER -+ @
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° : 1x sub-output

o : 2x sub-outputs in horizontal position

o : 3x sub-outputs in horizontal position

° . 4x sub-outputs in horizontal position

° . 2x sub-outputs in vertical position

o : 2x sub-outputs in both horizontal and vertical positions
° : 3x sub-outputs in vertical position

° : 4x sub-outputs in vertical position

o : Custom layout

° D: Click once to add one sub-output of the same size as the first one.
° 'II-II' : Delete the selected sub-output.

Step 2 Select a sub-output and set its position and size.
® Position:
- X: Set the initial horizontal position of the sub-output area.
- Y: Set the initial vertical position of the sub-output area.
® Size:
- W: Set the width of the sub-output area.

- H: Set the height of the sub-output area.

Sub-Outputs Reorganizing

Reorganizing sub-outputs refers to the re-layout of the output partitions of an output

connector as required.

After startup, Kompass FX3 will automatically detect the graphics card connectors and display

all the connectors in the output list on the left.
v
° = : Enable the output.

x
L = : Disable the output.
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Step 1

o M : Delete the output.

Click E to change the output name, connector binding relation and resolution.
Click and drag the sub-outputs on the right to reorganize them.

Figure 5-6 Sub-outputs reorganizing

Edit Output

Output 1-1
(SDRG1)

Output 1-1
(SDRG1)

Output 1-2 Qutput 1-4
(SDR,G1) (SDR,G1)

ODNMMEHBEEED + @

(Open Identify| Hane |Output 1-6 (4573 3 ¥ 14033 S S : Ounx ® o @0

You can change the size and position of the sub-output at the bottom.

Figure 5-7 Output adjustment

Hame |Qutput 4-1 {1920 . T|1080 . w1920 . H|1080 - Ratate |0

® Name: Change the current output name.

® X: Set the initial horizontal position of the sub-output or output on the stage. The adjusting

reference is the top left corner of the stage.

® Y: Set the initial vertical position of the sub-output or output on the stage. The adjusting

reference is the top left corner of the stage.
® W: Set the width of the sub-output or output.
® H: Set the height of the sub-output or output.

® Rotate: Set the rotation angle (clockwise) of the sub-output or output.

Figure 5-8 Canvas adjustment

° w: Drag to move the stage canvas.
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° @ 100% @): Zoom in or zoom out the canvas.

r.A
e L J: Canvas automatically returns to the origin. If the canvas moves out of the editing area,

click the icon to return it to the origin.

° 0/(/): Show or hide connector information.

° Ea / l:\:l : Show or hide connector borders.

Step 2 Click OK to complete the reorganizing.

After the reorganizing, you can add the layer image to the stage area. The mapping between

the sub-output and image is shown as follows.

Figure 5-9 Sub-output and image mapping

5.3 Manage Media

You can add the desired media files to the current media library. Kompass FX3 supports
pictures, videos, PowerPoint files, audio media files, NDI, websites, streaming mediaand sources

from data acquisition cards.

The supported media formats are as follows:

® Video: mp4, avi, mky, flv, mov, wmv, mpeg, m4v, m2ts
® Picture: jpg, jpeg, bmp, png, gif, ico

® Audio: mp3, aac, flac, amr, ape, wav, wma

e Office files: ppt, pptx, xls, xIsx, pdf, doc, docx

® Other formats: sensor, exe, image sequence
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E Note

You can add up to 15 PowerPoint files to the media library, with support for decoding

PowerPoint files up to 4K.

High-resolution image loading may be affected by hardware performance. The maximum image
resolution is 50000x3000.

Recommended video coding formats:

4K < resolutions < 8K: H.265 (HEVC) or VP9 recommended
Resolutions < 4K: H.264 (AVC) recommended

For a better image quality experience, the following video bitrates are recommended.

® Recommended video bitrates for SDR uploads — single media server and single graphics

card:
Type Video Bitrate Standard Frame Rate | Video Bitrate High Frame Rate (48
(24 Hz, 25 Hz, 30 Hz) Hz, 50 Hz, 60 Hz)
4320 (8K) 75 to 90 Mbps 110 to 135 Mbps
2160 (4K) 35 to 45 Mbps 53 to 68 Mbps
1440 (2K) 16 Mbps 24 Mbps
1080p 8 Mbps 12 Mbps

® Recommended video bitrates for SDR uploads — multiple media servers and multiple

graphics cards (frame synchronization required):

Type Frame Rate Video Bitrate Video Coding
4320 (8K) 60 Hz 30 Mbps H.265
2160 (4K) 60 Hz 30 Mbps H.264

E Note

If frame synchronization output is not required in the application scenario that has multiple

media servers and multiple graphics cards, please refer to the recommended video bitrates for

SDR uploads - single media server and single graphics card.

Video Media Requirements

The video playback performance varies depending on the graphics card. To ensure optimal

compatibility and smooth playback, please prepare and add media materials according to the

following specifications:
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® Requirements for single graphics card scenario:
- 4K video: Resolution < 4096 pixels (width/height), encoded in H.264
- 8K video: Resolution < 8192 pixels (width/height), encoded in H.265

- Super 8K video: Resolution > 8192 pixels and < 16384 pixels (width/height), encoded in
HAP

® Requirements for multi-graphics card scenario:
- 4K video: Resolution < 4096 pixels (width/height), encoded in H.264
- 8K video: Resolution < 8192 pixels (width/height), encoded in H.265

- Super 8K video: Requires segmentation, with all segments of equal duration.

E Note

Video playback must utilize hardware decoding, with a frame rate of 30/60 fps, and a

recommended video bitrate under 200 Mbps to ensure synchronization.

Graphics Card | Resolution Frame Rate Encoding Pixel Format Bitrate Range
Format
AMD 4096x4096 60 H.264 YUV4:2:0/YUV4:2:2 | 0 to 300 Mbps
3840%2160 60 H.264 (HDR) | YUV4:2:0/YUV4:2:2 | 0 to 300 Mbps
MPGT400 8192x4320 60 H.265 (HDR) | YUV4:2:0/YUV4:2:2 | 0 to 300 Mbps
HPGA4000 8192x4800 60 H.265 (HDR) YUV420/YUV422 0 to 450 Mbs
7680%4320 60 Prores422 YUV420/YUV422 No
HQ requirements
3840%2160 60 Prores422 YUV420/YUV422 No
HQ requirements
HPGA5000 8192x8192 60 H.265 (HDR) | YUV420/YUV422 0 to 150 Mbs
3840%2160 60 Prores422 YUV420/YUV422 No
HQ requirements
HPGA6000 8192x8192 60 H.265 (HDR) | YUV420/YUV422 0-150Mbs
3840x2160 60 H.265 (HDR) | YUV420/YUV422 No
requirements
HPGA4000 16384x4320 60 HAP YUV420/YUV422 No
HGPA5000 requirements
HPGA6000
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5.3.1 Add Media Files

You can select to import a single media file or a folder including multiple media files.

5.3.1.1 Add Local Files

Step 1 Click E" at the bottom left corner of the Media Library area, or right click the area to select
Add Local File.

Step 2 Select the target media files and click Open. Kompass FX3 will import the selected files to the

media library automatically.

® Importing a single file: Select the desired file and click Open to complete the importing.

® |mporting multiple files: Press the Shift/Ctrl key, select the desired files, and then click Open
to complete the importing.

® Drag and drop to import: Select one or multiple media files and drag them to the blank area

of the media library to complete importing.

E Note

e When you add a media file whose size exceeds the processing capacity of the graphics card
installed on the software server, the prompt Optimizable appears next to the added media
file in the Media Library area. To render and play this media normally, go to Help >
Transcoding and Encryption Assistant to optimize it.

e When the value of the width x height x frame rate of a video is greater than the
recommended value, or the value of the width or height is greater than 8192 pixels, the
prompt Optimizable appears.

¢ When the width or height of a picture is greater than 16384 pixels, the prompt Optimizable
appears.

e When a media file in hap format exceeds the recommended maximum resolution, the prompt
Optimizable does not appear.

e After the media file is added successfully, hover the mouse over the media and you can view

its basic information.

5.3.1.2 Add Local Folders

Step 1 Click n‘ at the bottom left corner of the Media Library area, or right click the area to select
Add Local Folder.
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Step 2 Select the target folder and click Select Folder. Kompass FX3 will import the folder and the

media files in it to the media library automatically.

You can also select one or multiple folders and drag them to the blank area of the media library

to complete importing folders quickly.

5.3.1.3 Add OSDs

Kompass FX3 supports the OSD as a kind of media.

Step 1 Right click the Media Library area to show the context menu and then select Add OSD.

Figure 5-10 Add OSD

Add OSD X

Preview: Text Width: 615px  Text Height: 82px

Please enter the OSD text

Text:

Please enter the OSD text

T o+ %

Name: Arial > 48
Color: | Pure Color Presets: [ HHENB
Char Space: |2 X Line Space: |1.3 ¥ | times Direction: | Horizontal
Scroll: | Static Speed: 3 s Infinite Scroll ~ Space: 48

Adaptive Word Wrap Display Width: 615 px  Display Height: 82

Horizontal Fold Fold Width: 615

OK Cancel
Step 2 Enter the desired content in the Text area.
Step 3 Adjust the font and style.

You can set the following attributes.
] B : Make the text bold or not.
(] f : Italicize the text or not.

o H : Underline the text or not.
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: Align the text to the left.

When the display area width is larger than the text width and the moving is set to Static,
align the text to the left of the display area.

: Center the text horizontally.

When the display area width is larger than the text width and the moving is set to Static,

center the text horizontally to the display area.

: Align the text to the right.

When the display area width is larger than the text width and the moving is set to Static,
align the text to the right of the display area.

o 1 : Align the text to the top.

When the display area height is larger than the text height and the moving is set to Static,
align the text to the top of the display area.

4

e T :(Center the text vertically.
When the display area height is larger than the text height and the moving is set to Static,
center the text vertically to the display area.
S
e — : Align the text to the bottom.

When the display area height is larger than the text height and the moving is set to Static,
align the text to the bottom of the display area.

Step 4 Enter a name next to Name.
Step 5 Set the font and font size.

Select the desired font from the drop-down list and the default font is Arial.

Select the desired font size from the drop-down list and the default size is 48. You can only

select a number from the drop-down list and you cannot enter a number manually.
Step 6 Set the font color.

Gradient and Pure Color are supported.

® Pure Color: Select Pure Color from the drop-down list and select the desired color block

next to Presets.

L]
When you are not interested in any of the preset colors, click A to open the Select Color

window to customize your own color, and then click OK to complete the pure color settings.
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Color: | Pure Color A Presets: @ HE B

® Gradient: Select Gradient from the drop-down list and the default gradient color is

displayed.

Click two color blocks at the both ends of the gradient color to customize your own gradient

colors. Set the gradient angle to complete the gradient color settings.

Color: | Gradient Angle: |0

Step 7 Set the character spacing, line spacing, and text direction.

® Char Space: Set the horizontal distance between adjacent characters. A larger value results

in looser spacing, and a smaller value makes it tighter, ranging from 0 to 30 pixels.

® |ine Space: Set the vertical distance between consecutive lines of text. A larger value results

in looser spacing, and a smaller value makes it tighter.

® Direction: Set the orientation of the OSD text. The options include Horizontal and Vertical.
Step 8 Set the moving effect and speed.

® Scroll: The options include Static, From Left, From Right, From Top and From Bottom.

® Speed: Set the moving speed. This parameter is available when the moving effect is not
Static.

® |Infinite Scroll: Set whether the scrolling text should seamlessly connect.

- Checked: The scrolling text will seamlessly connect the end of one sequence with the
beginning of the next. If selected, you must also set Space, which defines the spacing

between the end of one scroll and the start of the next.

- Unchecked: The text will complete one scroll before starting the next.
Step 9 Set the OSD adaption information.

® Adaptive: The OSD text adjusts automatically.

- Checked: When enabled, the text display area will automatically adjust based on the

text size to ensure a complete and logical presentation.

- Unchecked: You can manually adjust the text display area to meet specific layout

requirements.

® Word Wrap: The continuous text wraps naturally based on display width, preserving content

coherence.

- Checked: You must set the OSD display width in Display Width. After setting, the text
display area will automatically wrap according to this width, ensuring that the text is

completely and suitably displayed
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- Unchecked: The OSD text will be displayed within the set Display Width. If in a scrolling

mode, the text will scroll within this width.

® Horizontal Fold: Strictly segments according to folding width, potentially truncating text and

leaving blanks, suitable for structured layout needs.

- Checked: The OSD text will forcibly wrap according to the set Display Width, even if it

leads to truncating text and leaving blanks, thus meeting specific formatting demands.

- Unchecked: The OSD text will not wrap, presenting in a continuous format.

Step 10 Click OK to complete the OSD settings.

5.3.1.4 Add Digital Clocks

Kompass FX3 can set a digital clock as a media. You can view the details of the current date

and time.
Step 1 Right click the blank area of Media Library and select Add Digital Clock.

Figure 5-11 Add digital clocks
Add Digital Clock

Preview: Width: 600px Height: 72px

2023-09-12 13:56:56

HEN Custom: A
Forward Backward 0 sido sihjo | min |0
paragraph of text preceding the date)
2023-09-12 b
Date Time Week

Single Line Wrap

Cancel

Step 2 Enter the clock name and select the desired text font and size from the drop-down list next to

Name.

Step 3 Select the desired color block next to Color to set the clock text color.
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Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

4
Click A next to Custom to open the Select Color window to customize your own color. Set
the value of the background transparency next to Alpha channel. The value ranges from 0

(totally transparent) to 255 (opaque).
Set the clock offset information, which includes the number of days, hours, minutes or seconds.

® [Forward: Set the time to offset before the current time.

® Backward: Set the time to offset after the current time.
Enter a paragraph of text which will be displayed preceding the date.

Select the desired date format from the drop-down list next to Style. Three formats are

provided.
Select the clock content. The options are as follows.

® Date: After checked, the current date will be displayed.
® Time: After checked, the current time will be displayed.

® Week: After checked, the current week will be displayed.
Set the desired clock display mode. The options include Single Line and Wrap.
Set the style of the clock content below the Preview area.

You can set the following text attributes.

(] B : Make the text bold or not.

° I : Italicize the text or not.
U ,
® —: Underline the text or not.
° i : Click this icon to open the Select Color window to change the text background color.

Set the value of the color transparency next to Alpha channel. The value ranges from 0

(totally transparent) to 255 (opaque).

Step 10 Click OK to complete the digital clock adding.

After the clock is added successfully, right click the added clock and select Edit to open the
clock editing window. After you complete the editing, click Apply to change the clock display

information of all the programs.
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5.3.1.5 Add Sensors

Step 1

Step 2

Step 3

Step 4

Step 5

Kompass FX3 supports adding the data acquired by the sensor, and can display the sensor data

on the screen.

In order to use the time data generated by a timecode generator, the connection between the

timecode generator and media server (built-in Kompass FX3) must be established in advance.
Right click the blank area of Media Library and select Add Sensor.

Figure 5-12 Add sensors
Add Sensor

Preview:

00:00:00:00

B I UL 2%
Name:
Color: [E
Model: |Timecode
Type: |MTC
Text: (Add fixed tex ~fault data)

Layout: Vertical Horizontal Spacing: [0px .| ( en text and data)

Cancel

Enter the sensor name and select the desired text font and size from the drop-down list next to

Name.
Select the desired color block next to Color to set the clock text color.
N
Click A next to Custom to open the Select Color window to customize your own color. Set

the value of the background transparency next to Alpha channel. The value ranges from 0

(totally transparent) to 255 (opaque).
Select the model of the connected sensor next to Model.

The sensor models are classified based on the physical quantity and measurement principles of

the sensors.

Select the sensor type of the current sensor model next to Type.
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The sensor types are differentiated based on specifications and performance parameters of the

sensor models.

When playing the timecode data, the data type set in Type must be consistent with the data
type generated by the timecode.

Step 6 Enter certain text that needs to be displayed preceding the default data.
Step 7 Select the layout mode for the fixed text and sensor data next to Layout.

® \Vertical: The fixed text and sensor data are displayed in two lines, with the fixed text on the

first line and the sensor data on the second line.

® Horizontal: The fixed text and sensor data are displayed in one line, with the fixed text on the

left and the sensor data on the right.
Step 8 Set the distance between the input fixed text and the sensor data next to Spacing.
The value ranges from 0 px to 500 px.

Step 9 Set the style of the sensor text below the Preview area.

(] B : Make the text bold or not.

f : Italicize the text or not.

[ ]

U .
® —: Underline the text or not.
L2

— : Click this icon to open the Select Color window to change the text background color.

Set the value of the color transparency next to Alpha channel. The value ranges from 0

(totally transparent) to 255 (opaque).

Step 10 Click OK to complete the sensor adding.

5.3.1.6 Add Image Sequences

Kompass FX3 supports adding the images in a folder, and automatically plays those images of

the same format.

Currently, Kompass FX3 only supports BMP, JPG, PNG, TGA, and TIFF image files for image

sequence playback.

Step 1 Right click the blank area of Media Library and select Add Image Sequences.
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Step 2

Step 3

Step 4

Step 5

Step 6

Figure 5-13 Add image sequences
Add Image Sequences
Folder:
Browse
Format:

Playback:
Automatic

Frame Rate:
30

(]

Click Browse to select the directory where the image files are located.

Click the drop-down menu below Format to select the desired format for playback.
The system automatically reads the compatible formats in the current folder.

Click the drop-down menu below Playback to select the desired playback mode.

® Automatic: When using the image sequences as media for playback, the images will play

automatically.

® Manual: When using the image sequences as media for playback, the playback of the images

will require manual activation, otherwise only the first image will be displayed.
Set the image switching speed in the Frame Rate section, with a range of 1 to 60.

The smaller number, the slower the playback speed. This item is invalid when Manual playback
is selected.

Click OK to complete the adding.

Once the image sequences have been added into the media library, this media is automatically
named after the folder where the images are located. If you want to rename the media, right

click it and select Rename to give it a new name.
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5.3.1.7 Create Media Copies

Kompass FX3 supports the creation of copies of the added OSDs, digital clocks, sensors, image
sequences, and media collections. After a copy is created, the copy can be edited to quickly
complete the addition of a new media.

Step 1 Right click an added media and select Create Copy, and the system will automatically add a

copy of the selected media.
The copied one is named with the original media name plus a number.
Step 2 Right click the copied media and select Edit to change the media properties.

Step 3 Click OK to complete the editing of the media copy.

5.3.1.8 Add NDI Input Sources

Before adding an NDI input source, you must configure the NDI source image size and position
in NDI Sender and enable NDI so that Kompass FX3 can search and find the NDI source and add
it.

E Note

The computers running the NDI Sender and Kompass FX3 must be on the same network

segment.

Configurations in NDI Sender

Step 1 Doubile click the NDI Sender shortcut on the desktop to open the NDI Sender software.

Figure 5-14 NDI Sender

0 NDI Sender

Name: |(GJSJ1054-P

1 | Screen:0(1920x1080)

. | Start || Reset

Step 2 Enter an NDI name.

Step 3 Click Reset.
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After the name is changed, you must click Reset to make the setting take effect.
Step 4 If there are multiple screens in NDI Sender, select the screen that you want to send.
If you want to send multiple screens, select the first screen that you want to send.
Step 5 Click Select ROI, click and drag the mouse to select the display area that you want to send.

In the Sent ROI area, you can see the position and size of the sent image. You can also change

the x, y, w and h values to change the image position and size.

® x: The horizontal offset from the sent area to the selected screen's left edge
® y: The horizontal offset from the sent area to the selected screen's top edge
® w: The horizontal width of the sent area

® h: The vertical height of the sent area
Step 6 Click OK to complete image settings in NDI Sender.

Step 7 Click Start to complete NDI Sender settings.

E Note

After the settings, you can click Show ROI to see the image position and image size you have

set.

Add NDI Sources

Step 1 Right click the blank area of Media Library in Kompass FX3 and select Add NDI Media.

Step 2 The system will automatically search on the current network segment for all the devices with
NDI enabled.
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Figure 5-15 Add NDI sources
4dd WDI Media

NDI List

IP

172.18.12.126:5961

OK Cancel
Step 3 Select the NDI sources from the NDI list.

Step 4 Click OK to complete NDI source adding.

E Note

After adding NDI sources, you can right click an NDI source and select Edit to change the NDI

source name.

5.3.1.9 Add Sources from Capture Devices

Kompass FX3 can obtain input sources via the capture card.

Figure 5-16 Capture card connection

VideoSourte . Capture Device

Media Server

Step 1 Right click the blank area of Media Library and select Add Acquisition Equipment.
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Figure 5-17 Add capture device
Acquizition Equipment

Name Integrated Camera

Device Name Integrated Camera

Resalution 1280 x 720

Frame Rate

oK Cancel

Step 2 On the displayed window, enter the capture device name next to Name.

Step 3 Select a capture card next to Device Name.

The system will automatically read the resolution and frame rate.

Step 4 Click OK to complete adding the capture device.

5.3.1.10 Add Website Sources

Prerequisites

The computer running the software is connected to the network.

Operating Procedure

Step 1 Right click the blank area of Media Library and select Add Website.
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Figure 5-18 Add website

Edit Website URL

Website Page - 4

Maode

Native

Website URL: | AddTab |

Tab -1 https://www.bing.com/

oK Cancel

Step 2 Enter the desired website name in the Resource Name area.

Step 3 Select the display mode for the added website in the Mode area. The options include Native

and Screenshot.

e Native: During playback, the stage editing area does not provide a preview. Instead, it is
displayed directly on the extended screen, and the output image can be controlled using the

mouse.

It is NOT recommended to use this mode when the resolution of the added webpage

exceeds the graphical card processing capabilities of the media server.

® Screenshot: During playback, the software captures the image from the webpage window
and renders it onto the display screen connected to the connector, and allows for the image

to be cropped if needed.
Step 4 Enter the tab name in the left text box in the Website URL area.
Step 5 Enter the complete website domain name in the right text box.
Step 6 Click Add Tab to add a new tab page.
Step 7 Enter the tab name and domain name of the new tab page.

Step 8 Click OK to enter the added website.
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Figure 5-19 Website page (screenshot mode)

o‘ A v: {0 w: 1600 |H: [s00 | [Apply Output

m Microsoft Bing mages  Videos - signin e Rewards (@

T — .

© Life's good in the swamp!

& BiE

@ FRERERSEB

< ‘ B BMREFARRI TRMER EFA

If the screenshot mode is selected, when a super-large browser image is added, which exceeds
the processing capacity of a single graphics card on the media server, you can crop the bowser
image to several parts and then mosaick them together in the program to finally display the

whole webpage content.

You can complete the webpage cropping configuration using the following parameters:
® Y: Sets the starting vertical coordinate for the cropping, based on the top-left corner.
® W: The horizontal width of the cropped image.

® H: The vertical height of the cropped image.

Apply: Click Apply to make the parameters take effect.

® Webpage Output: Adjust the size of the output webpage by selecting an output resolution.

E Note

If the webpage resolution is too large, drag the thumbnail in the bottom right to select the crop

area.
e Hold the spacebar to drag the bottom right canvas.

e Hold the Ctrl key and scroll the mouse to zoom in or out of the bottom right canvas.

Step 9 Click x at the top right corner to close the website and complete adding the website.
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E Note

e When multiple tabs are opened, the tab where you stay on before closing the website will be
used as the input source.

¢ If you opened other website pages and the new page is displayed on the new tab, the
system automatically adds the new tab page.

¢ If you require long-time webpage playback, it is advisable to configure software to
automatically restart at scheduled intervals via Settings > System Settings, in order to
periodically clear the webpage cache.

5.3.1.11 Add Streaming Media

Kompass FX3 supports adding streaming media in rtsp, rtmp, http and https formats as input

source.

Step 1 Right click the blank area of Media Library and select Add Streaming Media to open the
window of adding a media network address.

Figure 5-20 Add streaming media

Streaming Media Address

Please enter a URL

Streaming Method

Step 2 Enter the media path in the URL field.
The path must begin with "rtsp://", "rtmp://", "http://" or "https://".

Step 3 Select the streaming transmission protocol in the Streaming Method section. The options
include UDP and TCP.

Step 4 Click OK to complete adding the media path.
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5.3.1.12 Add Media Collections

Multiple videos or videos and pictures can be combined with a specific order to form a new
video source called media collection. The videos and pictures in the collection can be played

automatically according to the set mode.

E Note

The PowerPoint files, NDI sources, websites and media paths cannot be added to the media

collection.

Step 1 Right click the blank area of Media Library and select Add Media Collection to open its

window.

Figure 5-21 Add media collections
Add Media Collection

All Media Collection Media

Select All Select All || Delete

Name ype tion | Duration Vi ion Duration Loop

> B Test Pattern . 00:10:00 1
== 1jpg ic... 3840x2160 00:10:00 - 00:10:00 1
™ 2jpg

00:10:00
00:10:00
00:10:00
00:10:00

00:10:00

Name |Collection 1 Transition |Fade Playback | Sequential v

OK Cancel

Step 2 In the All Media area, select the media files you want to add to the media collection
Step 3 Click in the middle to add the selected files to Collection Media.
You can click and drag the media to adjust its order in the collection media.

Step 4 For picture media, select a picture in Collection Media and click the value in the Duration

column to change the playback duration of the picture.

For video media, select a video in Collection Media and click the value in the Loop column to

change the number of times that the video can be played consecutively.

E Note

e The duration of video media cannot be set.
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e The number of playback times of picture media cannot be set.

Step 5 In the Name filed, enter a name for the media collection.
Step 6 In the Transition filed, select a media switching effect. Supported effects include Fade and Cut.

Step 7 In the Playback field, select a playback order of media files in the media collection. Supported

orders include Sequential and Shuffle.

Step 8 Click OK to complete adding a media collection.

5.3.1.13 Add Control Commands

Kompass FX3 supports the control of the back-end splicers via the control commands. It is

recommended the trained personnel use this function.
Step 1 Select the Output Control tab.

Figure 5-22 Output control

Media Library

MName Device

Step 2 Click ﬁ‘ at the bottom-left corner or right click the blank area and select Add to open the
Edit Control Command window.
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Figure 5-23 Add control commands
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Step 3

Step 4

Step 5

Step 6

oK Cancel

Enter the control command name next to Name.
Enter the splicer information.

1. Select the connected splicer next to Select Device. The supported devices include the video

wall splicer and intelligent controller.
2. Enter the splicer IP address next to Device IP.
3. Enter the port number for the external control next to Port Number.
Configure the control command.

1. Select the control command type next to Command Type.

2. Enter the control command value next to Value. For the control command values, please

refer the control protocol of the corresponding splicer.

Click OK to complete the settings.

a Note

e Each control command is a media file.
e The playback duration of the command media is fixed to 3s. If a program has the command

media only, the output will be black for 3s.
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5.3.2 Cloud Media

Kompass FX3 supports acquiring playback media from VNNOX.

5.3.2.1 Register Account

Step 1 Click Login at the top right to open the login window.

Figure 5-24 Login window

Login

Account

[] Phone Number

0086 Chinz ¥

Drag slider to verifs

Get Verification Code

| agree to the Ter

No account ? ** Select Server

Step 2 Click Select Server to enter the server selection interface.
Step 3 Choose a server node, then click OK.

Step 4 Click Register Now to enter the registration interface.
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Figure 5-25 VNNOX registration

Sign Up
o Identity Verification Complete Account Information Done

[ Phone

0086

Already have an account? Log in

Step 5 Choose the registration method. The options include Phone and Email.
Step 6 Enter your phone number or email.

Step 7 Check | agree to Terms of Service and Privacy Policy.

Step 8 Click Send Code and complete the slider verification in the pop-up.
Step 9 Enter the received verification code into the text box.

Step 10 Click Next to enter the Complete Account Information interface.
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Figure 5-26 Complete account information

Sign Up

{’J\:\ Identity Verification o Complete Account Information Done

* User Name

* Password

* Confirm Password
* Enterprise Name

* Enterprise Address
* Business Role

Application Scenarios (Select all that apply.)

S

Step 11 Fill in the user name, password, and enterprise information, then click Submit to complete

registration.

5.3.2.2 Log In Account

Step 1 Click Login at the top right to open the login window.
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Figure 5-27 Login interface

Login

Account

b Email

Get Verification Code(10s)

| agree to the T

No account 7 Reg ** Select Server

Step 2 Click Select Server to enter the VNNOX server selection interface.
Step 3 Choose a server node, then click OK.

Step 4 Click Verification Code or Account to select login method.

Step 5 Enter the account information.

For verification code login, after entering your email, drag the slider to the far right and get a

code, and then enter the received code into the text box on the left.

For account login, after entering your user name and password, drag the slider to the far right

to complete verification.
Step 6 Check | agree to the Terms of Service and Privacy Policy.
Step 7 Click Login to enter the device authorization verification interface.

Figure 5-28 Device authorization verification
Device Authorization Verification
Login de rust protection is enabled. Please

enter the verification code sent to your email.

Emailzwzlkf@novastar.tech

Drag slider to venify

Get Verification Code
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Step 8

Step ¢

Drag the slider to the far right to receive the verification code by email or phone.

Enter the received verification code in the text box.

Step 10 Click OK to complete the login.

5.3.2.3 Obtain Cloud Media

Step 1

Step 2

Step 3

Step 4

In the media library area, click Cloud Media to enter the interface.

Figure 5-29 Cloud media

Local Media Output Control

items C

Approved A  Vvideo

4 Family.mov Approved & Video

% Mountain.... Approved & Video

Click a next to the media to download it locally.

The downloaded media are stored in the cloud media path you set under Settings > System

Settings. Changing the path will save files to the new location.
Click Local Media to enter the local media interface.

Double click Cloud Media Folder to view the downloaded media.

5.3.3 Manage Media Files

Renaming

® Right click the media file or folder and select Rename. Enter a new name in the text box that

appears.

® Click the media file or folder and press the F2 key. Enter a new name in the text box that

appears.

Deleting

There are three methods to delete a media file.
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® Select the desired media file and click .
® Right click the media file and select Delete.

® Click the media file and press the Delete key.

Management

You can create folders to classify the added media files.

® (Click ﬁ at the bottom left corner in the Media Library area, and then select New Folder
and name the folder.

® Right click the Media Library area, and then select New Folder and name the folder.

® Select the desired media files and drag them to the new folder for better classification and

management.

® Change the order of the files or folders by simply dragging and dropping them.
Switching View

Click the icon next to Media Library to switch the view mode.

® |n list view mode, click to switch to the thumbnail view mode. All media files will be

displayed in thumbnails and folders will not be displayed.

® |n thumbnail view mode, click @ to switch to the list view mode. The media files will be

displayed in folders.

5.4 Edit Programs

The playback unit of Kompass FX3 is a program. Each program supports at most twelve layers

and one audio.

5.4.1 Edit Layers

Click and drag a media file to the layer in a program, and then adjust the layer in the stage

editing area, such as the layer size and position.

Step 1 Select a media file in Media Library and drag it to the desired layer or output area.
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Step 2

Figure 5-30 Edit programs
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If the added media is an encrypted video converted using Transcoding and Encryption
Assistant, when dragging the media to the target destination, you need to enter the password
to decrypt the media in the pop-up dialog box. Alternatively, in the media library, right click the

encrypted video, select Decrypt, and enter the password before you add the media.
Adjust the layer size, position, rotation and priority.

Figure 5-31 Adjust layers

-

X0 - Y|0 - W[1920 7| H|1080 - | Rotate|0

® Position adjustment: Drag and move the layer to adjust the layer position quickly, or fill in

the values for the following parameters to precisely adjust the layer position.
- X: Set the distance between the left edge of the layer and the left edge of the stage.
- Y: Set the distance between the top edge of the layer and the top edge of the stage.

® Size adjustment: Drag the layer edge to adjust the layer size quickly, or fill in the values for

the following parameters to precisely adjust the layer size.
- Width: Set the layer width.
- Height: Set the layer height.

- Double click the layer to automatically fill the located connectors. Double click again to

return the layer to its original size.

® Rotate: Set the angle by which the layer rotates clockwise.
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® Priority adjustment:
- .-l: Bring the selected layer forward.
- r.: Send the selected layer backward.

|
- =l Bring the selected layer to front.

o
' Send the selected layer to back.

).

- : Make the selected layer fill the output area.
Step 3 Set the rendering mode for the image displayed in the stage editing area.

Select the desired rendering mode below the stage area. The options include SDR and HDR10.
® SDR: Preview the output image displayed in the stage area in SDR format.

® HDR10: Preview the output image displayed in the stage area in HDR10 format.

E Note

e Before you configure the rendering mode, go to Settings > Output Settings to enable HDR.

e When HDR10 is set, the monitor where the software is installed must support HDR and the
HDR playback function is enabled.

e If the monitor does not support HDR and HDR10 is set, the image may be displayed

abnormally such as exposure, but the output will not be affected.

Step 4 Set whether to play the layer audio.

Click the audio icon in the Layer column on the left of the program columns to set whether to

play the layer audio.
° n: Play the audio that comes with the layer.
° m: Do not play the audio that comes with the layer.
Step 5 Group the media.
1. In the stage editing area, select the target media.
Press the CTRL key and click the mouse to select multiple media.

2. Right click to open the context menu and select Create Group.

- For the media in the same group, the same icon appears on the top left of each layer as

shown below.

- For the group media, you can perform the playback, fast forward, rewind, pause and

stop operations on all the media in the group simultaneously.
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Figure 5-32 Layer group

Step 6 Lock the layer media.

After a layer is edited, you can lock the layer to avoid unexpected changes to the layer caused

by misoperation.
1. In the stage editing area, right click the target media to open the context menu.
Figure 5-33 Lock media

Delete
Delete All

Lock

Fill Qutput Area

Group

Locate Media Resource

2. Select Lock to lock the selected media. After locked, the layer cannot be moved.

- After the layer is locked, lock appears at the top right corner of the layer in the

Program Management area.

- After locked, the layer cannot be moved or re-sized, and the layer input source cannot

be replaced.

- Right click the locked layer and select Unlock to unlock the layer.

E Note

¢ In the stage editing area, you can click and drag to select multiple layers.

e After you have completed all the editing in the stage editing area, click B to lock the

stage to avoid the layout changes in the stage caused by misoperation.
e Select Locate Media Resource to quickly find out where the media file is in the media library.
o If the selected media is a webpage media that has multiple tab pages, you need to set the
desired playback tab for each media respectively.

e Right click the layer and select Rename to give the layer a new name.
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e Right click a layer and select Bind Screen Group to modify the binding relationship between
the layer and the screen.

e Inthe program management area, right click a media and select Locate Media Resource to
quickly locate the media in the media library.

¢ Inthe program management area, right click a media and select Access File Location to

open the storage location of the current media on the media server.

5.4.2 Set Program Properties

Right click a program to open the context menu as shown in the following, and you can set the

program properties as needed.

Figure 5-34 Set program properties
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Delete Del
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= Ctrl+V

Panda.mov

Layer3 b:‘:’

—

dx 2 - . -
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Ll = Main KV
Layer5 Main Media
fx .
After Program Ends
Layerb Bind Screen Group
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® | ock: Lock the selected program. Once locked, you can only play, pause, copy and insert the

program.
® Rename: Give the program a new name for better management.

® Delete: Delete the current program. All the layers, layer settings and media properties will be
deleted.

® Copy: Copy the layers, layer settings and media properties in the current program.
® Paste: Paste the copied program to a new program.

® Insert and Play: Play the currently-selected program. The program being played is paused

until the playback of the inserted program ends.
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- If the main media is set to None, this function is not supported.

- If the programs are scheduled, this function is not supported.

- Inlink mode, the insert and play status is synchronized to the slave or backup terminal.
- In pre-edit mode, this function is not supported.

- During the playback of a media collection, after the playback of the inserted program
ends, the paused program starts to play from the beginning rather than from the

pausing point.

- When there are continuous inserted programs, after the playback of those programs
ends, the program before the last insertion rather than the program before the first

insertion continues to play.
- After the insertion, the paused program has a different label color for easy distinction.

® Add Columns to Left: Insert a specified number of program columns to the left of the

currently selected program column.

® Add Columns to Right: Insert a specified number of program columns to the right of the

currently selected program column.

E Note
Y

e To add program columns to left or right, click "W to set the number of columns to be added
first and then click Add Columns to Left or Add Columns to Right.
e When you perform the copy and paste operations on a program, the pasted program

becomes a newly-added program.

® Main KV: Set the current program as the main KV (key video).

- After a KV program is set, if you add a layer in another no-layer program, the added-
layer will automatically match the layer style and properties in the KV program,
including the position, rotation, locking, sound channel mapping, graphics card
mapping, start playing and stop playing settings, and layer grouping of each layer in

main KV.

- If you set KV program after you add the layers to an empty program, the layers will not

follow the layer style and properties in the KV program.

® Main Media: Set which layer is used as the main media. The playback timing and program

switching are all based on the main media.

When Main Media is set to None, no program jumping is performed. All media in the
program will be played completely and with a set ending action after the program playback

ends.
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E Note

If Main Media is set to None, the program does not support the insert and play function, but
another program can be inserted before it.

If Main Media is set to None in the pre-edit mode, click Take to make the setting take effect.
If Main Media is set to None and then the program is added to the schedule list, the
playback of the program is not limited by the set loop times and the program jump settings
do not take effect.

If you have added the program to the schedule list, Main Media cannot be set to None.

Main Media does not support the cross program continuation function.

After Program Ends: Set the actions after the current program playback ends.

Loop Playback
Jump to Next
Stop Playing

Jump to KV

Jump to

Apply to All
- Loop Playback (default): The current program will be played circularly.

- Jump to Next: The next program will be played automatically after the current program
is stopped. If the program is the last program of a specific screen, this function is not

available.
- Stop Playing: The playback will be stopped after the current program is stopped.

- Jump to KV: The main KV program will be played automatically after the current

program is stopped.

- Jump to: You can select the desired program and the specified program will be played

automatically after the current program is stopped.
- Apply to All: Apply your selected option for After Program Ends to all the programs.

Bind Screen Group: Associate programs with screens and then group the programs by

screens.

Once a program is bound to a screen, by selecting different screens, you can view the

programs bound to each screen, allowing for rapid switching between programs.

Timecode: Set the timecode-based playback control for the current program, specifying the

time to start, pause, resume and stop the program playback.
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As shown in the below figure, (00:00:00:00 as the timing base) the program starts the
playback at the 10th second, pauses the playback at the 30th second, resumes the playback
at the 40th second and stops the playback at the 50th second.

- When the scheduled playback function is enabled, the timecode settings are not

available.

- When the timecode function is enabled and the timecode settings are for a program

being played, the insert and play function is not available.

Figure 5-35 Timecode settings

Timecode Settings

Start
00:00:30:00 Pause

00:00:40:00 Continue

00:00:50:00 Stop

Save Cancel

5.4.3 Play Programs

After you have completed the program editing, play the programs through either of the
following two methods.

® Click D next to the program name in the Program Management area.
® (Click D next to the program name in the Playback area.

® (Click D or @ next to each media to play or pause the playback of the selected media.

® For the media of the same group, drag the progress bar of a single media to control the

synchronous playback of all the media in the group.

E Note

If there are no PowerPoint files in the playlist and the PowerPoint file playback mode is disabled,
you can use the arrow keys, Page Up and Page Down keys on the keyboard to switch
programs, and press the space key to start the playback.
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5.4.4 Play Programs by Screens

You can add multiple screens and manage the programs and outputs by screens.

Add Screens

On the main user interface, click 55 to add a screen.

Figure 5-36 Add screens

s @ m Pre-Edit
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Click the screen name to manage the programs and layers by screen groups.
e All: Click All to display the programs not bound to any screen and all layers.

® Screen name: Click each screen name to display the programs and layers bound to that

screen, as well as the layers not bound to any screen.

When adding screens, the system binds 10 programs to each screen automatically. If the
added screens exceed the default 50 programs, the system will automatically add 10
programs for each extra screen. When the automatically-added programs reach 100, the
system will no longer add programs automatically. Subsequent screens will require manual

program insertion and screen binding operations.

® Click the screen to select it. Click it again to deselect it, showing all programs and layers.

E Note

To let other programs to inherit the main KV layer properties, click All first, adjust the layer
layout and properties on the stage, and set the current program as Main KV. For subsequent

screen program edits, this will save time on adjusting the layer positions and sizes.
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Play Programs by Screens

Each screen can only play one program at a time. Playback across screens does not interfere

with each other. Use the following methods to perform playback.

Click the screen and it will automatically jump to the program list bound to the current screen.

Click D next to the program name to start playback.

Figure 5-37 Play programs by screens

rogram 6

Playback Instructions:

Each screen can only play one program in the program list at a time. Playback across screens

does not interfere with each other.

After selecting a screen, right click a program to insert a new program. The newly-inserted

program will automatically bind to the selected screen.

After selecting a screen, adding media to a layer will automatically bind that layer to the

selected screen.

Once a layer is bound to a screen, you can only add media to that layer within the bound
screen, but cannot add media to that layer of other screens since that layer does not exist

for other screens.
Right click a layer and select Bind Screen Group to quickly modify the layer's screen binding.

Removing all media from a layer already bound to a slit screen does not affect the layer's

binding to that screen.
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® Click X next to the screen name to delete the screen. When a screen is deleted, the layers
and programs bound to it will be automatically unbound, but the media in the added

programs and layers will remain unchanged.

5.4.5 Set Media Playback Properties

You can set whether to mute the playing, and set display image when the playback stops.

Step 1 Click the playing media in the Program Management area or in the Output area to select the

media.

Step 2 In the Media Properties area within the Output area, click Basic to set the basic properties of

the media.

Figure 5-38 Basic properties

x

Start Playing
Play

Stop Playing
Loop Playback

rogram Continuation |0

Lock Aspect Ratio

Accurate Frame Seek

Media Keep

® Volume adjustment: Adjust the output volume of the program media. Click 4) or dx to

mute or unmute the output.
® Start Playing: Configure the state of the current media upon starting playback.
- Play: The media enters directly into normal playback mode after the program begins.

- Hold on First Frame: The media remains frozen at the first frame while the program

starts playing, and can be resumed by clicking D next to the media name in the
Playback area in the top right corner.

® Stop Playing: Set the status or action when the playback of the current media ends.

- Hold on Last Frame: After the playback of the current media ends, the output displays
the last frame of the playback media.
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- Black Screen: After the playback of the current media ends, the output displays a black

screen.
- Loop Playback: The current media will be played circularly after the playback ends.

- Stop Playing: The playback will be stopped after the playback ends. When the media file

type is audio, this option is available.

® Cross Program Continuation: Enable the feature of cross program continuation, so that
selected media will continue playing seamlessly when switching between programs. Once
cross program continuation is set, the media will play according to its normal progress

without restarting from the beginning due to program switching.

Input a numerical value in the text box to determine the number of programs in which the

selected media will continue playing after its original program ends.
The main media does not support the configuration of cross program continuation.

® Playback Speed: Configure the playback speed of video or audio media. The value ranges
from 0.5 to 2.0, and defaults to 1.0.

- 1.0: The media plays at its original speed.

- Smaller than 1.0: The media plays slowly. The smaller the value, the slower the playback

speed.

- Larger than 1.0: The media plays quickly. The larger the value, the faster the playback

speed.
® | ock Aspect Ratio: Keep the aspect ratio of the media file unchanged during the adjustment.

® Accurate Frame Seek: Enable this function to precisely seek at and play an exact frame in a

video stream. Only videos, media collections and image sequences support this function.
® Media Keep: Check or uncheck the box to enable or disable the function.

- When enabled, the media will continue playing from the last position in the previous

playback after program switching.

- When disabled, the media will start playing from the beginning after program switching.

E Note

e When the media file type is a PowerPoint file, the basic property settings are unavailable.

¢ When the media file type is audio, Hold on Last Frame and Black Screen options are
unavailable.

e When the accurate frame seek function is enabled for the layer in the main KV program, the
setting does not apply to the layer in other newly-added programs.

e When the accurate frame seek function is enabled for a program, after the program copy

and paste operations, the function is also enabled for the pasted program.
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5.4.6 Trim

Media Trim

Within a program, by selecting a media and accessing its Media Properties, you can configure

the desired media playback duration by setting the start time and end time.
Figure 5-39 Trim settings

* Trim

Media 00:00:20:053

Playback |00:00:20:053 21 Applyto A

Start Time |00:00:00:000 ©O

End Time |00:00:20:053 @ D)

® Media: View the time length of the media.

® Playback: This is the time length the media is set to play, typically calculated by subtracting
Start Time from End Time. When the playback duration is adjusted, the media will play for
the newly set duration. The default playback duration for media other than video can be set

in Settings > Output Settings > Default Duration.

- If the Playback duration exceeds the interval between Start Time and End Time, the

media will repeatedly loop between these two time points.

- If the Playback duration is shorter than the interval between Start Time and End Time,
the media will begin at the start time and stop playing once the set playback duration

has elapsed.

- If the Playback duration equals the time interval between Start Time and End Time, the

media will play from the start time and stop at the end time.

- By clicking Apply to All, the playback duration for all media of the same type within the

layer can be synchronized to the current setting.

- Clicking O to restore the playback duration to the default value.

® Start Time: Set when the media begins playing. The start time must not exceed the playback

duration.
- Clicking O to reset the start time to 00:00:00:000.

- Clicking @ to set the current time point of the media playback as the start time.
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® End Time: Defines when the media playback should conclude, which should be later than the

start time but cannot exceed the playback duration.
- Clicking O to reset the end time to the actual ending time of the media playback.

- Clicking @ to set the current time point of the media playback as the end time.

® Clicking Reset in the upper right corner restores all settings to their default values.

E Note

e You can change the values of Playback, Start Time, and End Time for video media only.

e Other types of media only support modification of Playback.

Command Trim

When a command is added to the program, select the command and configure the trimming

parameters in the media properties area on the right.

Figure 5-40 Trim settings

< |00:00:03:000

Default Program Pause

Program Resume Program Stop

Send 00:00:00:000

® Playback: Set the command playback duration.

® Trigger: Set the command trigger conditions. The options include Default, Program Pause,
Program Resume, or Program Stop. When set to Default, you must specify the precise send

time for the command.
® Send: Set the command send time.
- Send time must be less than or equal to the media playback duration.

- If send time exceeds the media playback duration and the media isn't set to loop, the

command will not be sent.

5.4.7 Flip Pages

When the media type is Word, Excel, PDF, PowerPoint, or image sequence with a manual

playback mode, manual page flipping is required.
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For Image Sequences

Select an image sequence with a manual playback mode, and click Page in the Media

Properties area on the right side to expand the page flipping interface.

Figure 5-41 Manual page flipping

¥ Page

Previous Next Goto |1 - Frame

Page flipping can be done in the following ways:
® Click Previous or Next to view the previous or next image.
® FEnter a number in the text box next to Go to to jump to and play the corresponding image.

® Double click the name in the list below to directly switch to and play the corresponding

image.

For Excel Files

Select an Excel media, and click Page in the Media Properties area on the right side to expand
the page flipping interface.

Figure 5-42 Excel page flipping

The functionality of the page flipping buttons differs depending on the playback mode set in
Settings > Output Settings.

® \When the Excel playback mode is set to Native or Animation, manual page flipping methods

are as follows:
- : Click it to move leftward, with each click moving one column.
- : Click it to move rightward, with each click moving one column.

- : Click it to move upward, with each click moving one row.
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: Click it to move downward, with each click moving one row.
- : Click it to flip up, with each click flipping one page up.

: Click it to flip down, with each click flipping one page down.

: Click it to switch the Sheet page of the Excel table, with each click moving to one

Sheet page to the left.

: Click it to switch the Sheet page of the Excel table, with each click moving to one

Sheet page to the right.

® When the Excel playback mode is set to Picture, manual page flipping methods are as
follows:

- (=) nERy [PQU”]: Each click flips one page up.
[ - ] / [ ! ] / [PQD"]: Each click flips one page down.

For Other Files

When the media type is Word, PDF, or PPT, the page flipping interface appears as follows:
Figure 5-43 Page flipping
¥ Page

Loop Slide Show

Previous Mext

Page 1 of 8 Goto |1

® | oop Slide Show: When the media is a PowerPoint file, this feature is supported.
- Checked: PowerPoint file will loop playback.
- Unchecked: PowerPoint file will not loop playback.

® Click Previous or Next to view the previous or next page.

® Enter a page number in the text box next to Go to to jump to the specified page.

5.4.8 Set Layer Opacity

You can set the overlapping effect of the output images by adjusting the layer opacity.

Step 1 Click the playing media in the Program Management area or in the Output area to select the

media.
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Step 2 In the Media Properties area within the Output area, click Opacity to set the nontransparent
degree of the layer.

Figure 5-44 Set layer opacity

Media Properties

» Basic

» Opacity

Step 3 Drag the slider to adjust the layer opacity degree, or enter a value in the text box below Reset

to precisely adjust the layer opacity degree.

The value range is 0 to 100. 0 stands for totally transparent and 100 stands for nontransparent.

5.4.9 Set Layer Color

You can adjust the layer color parameters to adjust the output image effect. The related

parameters are shown below.
Figure 5-45 Layer image quality
¥ Color
Advanced Apply to A

Brightness

Contrast

Stauration

Hue

Basic Color Settings

Table 5-1 Color parameters

Parameter Description

Brightness Adjust the brightness or darkness of the image.

The value ranges from 0 to 100 and defaults to 50.
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Contrast Adjust the difference in brightness between light and dark areas of the image.

The value ranges from 0 to 100 and defaults to 50.

Saturation Adjust the strength or purity of the colors of an input source image. The larger
the saturation, the more vivid the input source image; the smaller the saturation,

the larger the image grayscale.

The value ranges from 0 to 100 and defaults to 50.

Hue Adjust the distinction between colors.

The value ranges from -180 to +180 and defaults to 0.

Apply to All Apply all the parameter settings to all the layers.

Advanced Color Settings

Step 1 Click Advanced to open the Advanced Color Settings window.

Figure 5-46 Advanced color settings

Advanced Color Settings

Temperature/Tone

emperature
Curve

Step 2 Select Temperature/Tone to adjust the color temperature, color tone and gain compensation

of the output image.

® Color Temperature: Adjust the cold or warm tendency of the image. The value range is [-
3000, 10000] and the default value is 0. Move the slide block leftward, the color will be

colder; move the slide block rightward, the color will be warmer.

® Color Tone: Adjust the color effect of the image. The value range is [-40, 30] and the default

value is 0.

® Gain Compensation: Adjust the image output effect together with the color temperature and

color tone. The value range is [-100, 100] and the default value is 0.
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Step 3 Select Curve to adjust the image channel or overall effect using the curve.

The curve can help to adjust the brightness value of full grayscale images such as low gray,
mid-tone, and high brightness. When the image is a low grayscale one and darker, you can raise

the left half of the curve to improve the brightness of the low grayscale part of the image.

When you want to adjust the overall image effect, select RGB; when you want to adjust a single

channel, select R, G and B and adjust the single channel, respectively.

When adjusting the curve, click the curve to create an adjustment anchor point, and then simply

drag the anchor point for adjustment.

E Note

e At most 17 anchor points can be added for each channel.

e Limitations: The moving range of multiple anchor points on the Y axis is 0-256, and the
moving range of multiple anchor points on the X axis is limited by the X values of other
points. Between two points, a draggable anchor point X value is added. Its adjustable range
is between the X values of the previous two points. If you drag it beyond this range, the
anchor point will disappear.

Apply Color Settings

® Apply to All: Apply the basic and advanced color settings to all the layers.

® Reset: Reset all the color parameters to defaults.

5.4.10 Crop Layers

Step 1

Step 2

Crop a certain part of the layer image and make it display in the output area.

The PowerPoint files do not support the cropping.

Click the playing media in the Program Management area or in the Output area to select the

media.

In the Media Properties area within the Output area, click Crop to set the cropping

parameters.

Figure 5-47 Crop layers

-

1920 - |1080 =
Width  Height
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Step 3 Set the position and size of the cropped area.

® Position:

- X:Set the distance between the left edge of the cropped area and the left edge of the

input source image.

- Y:Set the distance between the top edge of the cropped area and the top edge of the

input source image.
® Size:
- Width: Set the width of the cropped area.
- Height: Set the height of the cropped area.

The cropping takes effect in real time and the cropping result is shown as follows.

Figure 5-48 Cropping

5.4.11 Set Layer Effects

Layer effect settings include multiple stunning visual effects, such as keying, mask and flipping.

Step 1 Click the playing media in the Program Management area or in the Output area to select the

media.

Step 2 In the Media Properties area within the Output area, click Effect to set the related parameters.
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Figure 5-49 Layer effect settings
v Effect

Blur

Keying

Loop Scroll

Flip

3D Mapping

Fisheye
Strobe

Jitter

Mask

Blur

You can set whether to blur the layer image.
Step 1 Select Blur to turn on the function.
Step 2 Drag the slider to adjust the blurring degree.

The value range is 0 to 100, and it defaults to 0.
® (0: Do not blur the layer image.

® 100: Blur the layer image to the greatest extent.
Keying

Keying is used to key out a solid-color background and replace it with transparency.

o
Step 1 Click / and select the color area to be removed.

Step 2 Pick the desired color.

After the color is selected, the picked color, the color Hex and RGB values are displayed next to

- |
’ , Or you can also set the Hex and RGB values to specify the color.

Step 3 Select Keying to turn on the function and remove the selected color in the layer image.
Loop Scroll

Enable media scrolling in a continuous loop. Media will scroll in the specified direction with

adjustable speed.
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Step 1

Step 2

Step 3

Step 4

Select the media that you want to configure for scrolling.

In the Effect section of the media properties, check the box next to Loop Scroll to activate

scrolling playback for the media.

Specify the scrolling direction for the media.

Choose from four scrolling modes: From Left, From Right, From Top and From Bottom.
Adjust the scrolling speed.

The value ranges from 1 to 100, and it defaults to 5.

You can manually drag the adjustment bar or enter the desired numerical value in the adjacent

text box to set the scrolling speed.

Flip
Configure the media to play with a flipped image.
® Horizontally: Flip the media image horizontally, meaning the output image will be displayed
flipped from left to right.
® Vertically: Flip the media image vertically, meaning the output image will be displayed
flipped from top to bottom.
After selecting the desired flip option, check the checkbox next to Flip to enable the flip output.
3D Mapping
The 3D texture mapping function allows you to project the media onto different irregular-
shaped displays, such as curved or spherical screens.
Step 1 Check the 3D Mapping box to activate the function.
Step 2 Select Map Model File from the Mode drop-down list.
Step 3 Import a 3D model file in the Model File area. The model file format is n3dx.
Step 4 Set the original resolution of the media in the Texture Resolution area.
Step 5 Adjust the texture mapping parameters.

® Distance (m): The distance from the virtual camera position in the three-dimensional space
to the center of the model, defaulting at 1.0 m, with a range from 0 to 10 and increments of
0.1.

www.novastar.tech 72



NOVASTAR Kompass FX3 Multimedia Playback Software User Manual

e Horizontal (m): The horizontal offset distance of the virtual camera position in the three-

dimensional space, defaulting at 0 m, with a range from -10 to 10 and increments of 0.1.
e Vertical (m): The vertical offset distance of the virtual camera position in the three-

dimensional space, defaulting at 0 m, with a range from -10 to 10 and increments of 0.1.
® (Click O next to each parameter to reset it to its default value.

Click Apply to All in the upper right corner to apply the current settings for 3D mapping
parameters to all added media. Parameters applied include the model file, distance, horizontal,

and vertical data.

Click Reset in the upper right corner to restore all parameters set in the 3D mapping to their

default values.
Fisheye

The fisheye distortion effect allows the display to mimic the ultra-wide-angle, edge-distorted

visuals of a fisheye lens, suitable for spherical screens.

Check the Fisheye box to activate the function.

Figure 5-50 Fisheye effect

Fisheye

® Center X: Adjusts the horizontal center position of the fisheye effect on the selected media

for precise effect placement.
® Center Y: Adjusts the vertical center position for precise effect placement.
The value range is 0% to 100%, and it defaults to 50%.

® Radius: Control the fisheye effect's area size, with a default value of 20%, meaning the effect
impacts 20% of the object's width and height.

The value range is 0% to 50%, with 0% indicating no effect and 50% indicating it covers half
the width or height.

® Distortion: This calculates the embossing effect for the fisheye special effect, controlling its
strength and visual impact. By adjusting this parameter, the fisheye effect can manifest
varying degrees of concavity or convexity, enhancing the image's three-dimensionality and

visual appeal.

www.novastar.tech 73



NOVASTAR Kompass FX3 Multimedia Playback Software User Manual

Strobe

Jitter

The value range is 0.00 to 5.00, and it defaults to 3.00. The larger the value, the more
pronounced the concavity and convexity.

This create a flickering effect through rapid on-and-off imagery, designed to capture attention
and create a dynamic atmosphere.

Check the Strobe box to activate the function.

Figure 5-51 Strobe effect

hd Strobe

2 B reoeef| R (255 2| G (255 2[B [:

® Color: Set the strobe color.

- /: Click the eyedropper to select the desired color.

- Click the default white color block to open the color picker and choose a color.

- Enter a hexadecimal color code in the text box to set a precise color.

- Set the color by adjusting the RGB values in the text box.
® Rate: Configure how many times the strobe occurs per second.

The higher the value, the faster the strobe. The value range is 1 to 100, and it defaults to 10.
® Duration: Determine how long the opacity change lasts for the strobe color.

The value range is 0 to 100, and it defaults to 50.
® Fade: Set the proportion of fade-in and fade-out within the duration.

The value range is 0 to 100, and it defaults to 50.

Jitter is a visual effect that adds a dynamic feel to the image through slight or rapid vibration,

enhancing vitality and realism.

Check the Jitter box to activate the function.
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Figure 5-52 Jitter effect

® Rate: Set the speed of image movement within a default time unit.

The value range is 1 to 100, and it defaults to 2.
® X Offset: Set the horizontal displacement for the jitter based on the original media width.
® Y Offset: Set the vertical displacement for the jitter based on the original media width.

The value range is 0 to 100, and it defaults to 20, meaning a single displacement value is 20%

of the media's original width or height.

Mask

Masks use specific shapes to obscure part of the image, revealing only the content within the

mask to create a unique display effect.

Check the Mask box to activate the function.

Figure 5-53 Mask effect

Mask

® Shape: Choose the mask shape. The options include Heart, Triangle, Circle (Oval), and

Rectangle.
If you check Invert, the image outside the shape is displayed, while the inside is not.

® Center X: Set the X coordinate for the center of the mask's bounding rectangle based on the

original media width.

® Center Y: Set the Y coordinate for the center of the mask's bounding rectangle Based on the

original media width.

The value range is 0 to 100, and it defaults to 50, meaning 50% of the media's original width
or height.

® Width: Set the width of the mask’s bounding rectangle.
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® Height: Set the height of the mask's bounding rectangle.

5.4.12 Set Webpage Tabs

When you configure a webpage media for the layer of a program, this function is available.
When there are multiple tab pages, you can configure different tabs for the programs.

If you require long-time webpage playback, it is advisable to configure software to
automatically restart at scheduled intervals via Settings > System Settings, in order to

periodically clear the webpage cache.
Step 1 Select the desired webpage media in the stage or program area.
Step 2 Click Webpage Tab to show the tab setting options.

Step 3 Select the current webpage tab name next to Main Tab.

5.4.13 Set Sound Channel Mapping

You can configure the sound card for the layer media to output the media audio from different

sound cards.
Step 1 Select the desired media from the program management area or the output editing area.
Step 2 Select Sound Channel Mapping in the Media Properties area on the right side.

Only the media with audio information supports this function.

Figure 5-54 Sound channel mapping

Media Properties

¥ Sound Channel Mapping

Sound Card
Map01:Local/LG FULL HD (Z=FFR(R) EmEessa ~
Sound Channe
|r|Dur. 1 2
1

P

Step 3 Select the desired sound card from the drop-down list.
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Step 4

The default option is the sound card used by the software. Please refer to Audio Settings for

specific sound channel mapping settings.
Click the desired sound channel and sound track to configure the output channel for each track.

® At most 8 sound channels are supported. The specific sound track number depends on the

actual media.

® |f the media file does not contain any sound track information, the sound channel settings

are not supported.

E Note

After you set the sound channel and re-install the sound card, the configured parameters of the

sound card will be applied to a new card automatically.

5.4.14 Set Graphics Card Mapping

Step 1

Step 2

Step 3

Step 4

Step 5

Set the rendering graphics card for the layer media.

Click the playing media in the Program Management area or in the Output area to select the

media.

Select Graphics Card Mapping in the Media Properties area on the right side to set the related

parameters.

Figure 5-55 Graphics card mapping
Media Properties
¥ Graphics Card Mapping
De
Local

In Use

G1(Intel(R) UHD Graphics 770)

Change

G1(Intel(R) UHD Graphics 770)

Select the media output device from the drop-down list below Device. The options include the

local and slave device.
View the graphics card used by the current media below In Use.

Select the rendering graphics card from the drop-down list below Change.
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Step 6 Click Apply to complete the settings.

E Note

e The media server where the software is installed has multiple graphics card, the rendering
graphics cards will display at the bottom left corner of the layer, such as G1 and G2.

e The graphics card display area in green indicates that the layer rendering graphics card is
the same as the graphics card of the output connector and the output is normal.

e The graphics card display area in red indicates that the layer rendering graphics card is not
the same as the graphics card of the output connector and there is no output.

¢ When the media resolution is greater than that of the mosaic graphics cards and multiple
graphics cards are required for mosaic output, you need to use the layer mosaic and

configure the matched rendering graphics card for each layer.

5.4.15 Set Layer Properties

Select a layer in the Program Management area, and then select the Properties tab on the

right pane to show the layer property settings interface.

Figure 5-56 Layer properties
Playback Update Tim

¥ Sound Channel Mapping

Sound Card

Map01:Local/LG FULL HD (HD Audio Driver f

1 Channe

Layer properties involve configuring the audio channel mapping for the media within the layer.
Before modifying the layer's channel mapping, you need to complete the sound card mapping

configuration in Audio Settings.
The relationship between layer channel mapping and media channel mapping is as follows:

® |f you modify the layer channel mapping first and then add the media, and if you
subsequently modify the media channel mapping, the output will follow the modified media

channel mapping.

® [f you add the media first and then modify the layer channel mapping, the existing media
within the current layer will retain its original channel mapping. Media added thereafter will

follow the layer's configured channel mapping for output.
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5.4.16 Set Scheduled Programs

After the program editing, you can realize automatic playback of the programs according to the
scheduled time and times.

Step 1 Click > Edit Scheduled Playback at the bottom right of the main user interface to open
the Scheduled Playback window.

Figure 5-57 Scheduled programs

Scheduled Playback

Step 2 Click New Task at the top right of the window to create a new playback task.

Figure 5-58 Playback tasks

Scheduled Playback

askl

from 2023.12.18 * |t0|2023.12.18 (@

Cancel | [ Enable

Step 3 Set the start date and end date of the task in the Effective area.

Step 4 Click @ next to the effective time to add a new playback task.
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Figure 5-59 Set scheduled programs

O x

Program List Plan List t 4 (Delete

Ho Program List Ho Program List Count
Program 1 Program 1 1
Program 2 Program 2 1
Program 3
Program 4
Program 15

Program 16

Total scheduled duration:

oK Cancel

1. Select the desired programs in the Program List area on the left.

2. Click >> to add the selected programs to Plan List.

The programs will be played according to the sequence (from the top to the bottom) in the

Plan List area. If you want to adjust the playback sequence, check the box next to the

desired program and click T or i to adjust the sequence of the selected program.

Only one program sequence can be adjusted at a time.
3. Double click the play count on the right side of the program to set the playback times.

After the setting, the software will automatically rearrange the program playback order

according to the set count to minimize consecutive playbacks of the same program.
The play count range is 1 to 999.

If a program play count exceeds 1, the system will first play programs in order. After
completion, for programs with a play count greater than 1, the system will automatically loop

through the list until the set play count is reached.

After the setting, the system will automatically calculate the total duration of the planned
programs. If the total duration exceeds 24 hours, program configuration cannot be

completed.

4. Click OK to complete the settings.

Step 5 Click OK to show the tasks and plans.
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Step 6

Step 7

Step 8

Step ¢

Figure 5-60 Set playback tasks

Scheduled Playback

023.12.18 - |t0|2023.1218 - |@

Plan1: |Program 1,Pr...

OK Cancel | [ Enable

Select the program playback mode next to Mode. The options include Time and Times.

® Time: The programs will be played by their own durations circularly.

® Times: The programs will be played according to the set playback times.
Set the start and end time within the schedule range.

1. Set the automatic start time of the program in the From area.
2. Set the automatic end time of the program in the to area.

When the playback mode is set to Times, the end time of the program is 23:59:59 by default

and cannot be changed.
Set the program playback times.

Click the number next to Times to activate the times setting function. Enter the desired times
and then the program will be played automatically according to the set times. When the
playback mode is set to Time, the playback times of the program is 1 by default and cannot be

changed.

Set the program playback date. The options include Every day, Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday and Sunday.

® Every day: The plan will be played every day automatically according to the schedule within

the effective time range.

® Monday: The plan will be played every Monday automatically according to the schedule

within the effective time range.

® Tuesday: The plan will be played every Tuesday automatically according to the schedule

within the effective time range.
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® Wednesday: The plan will be played every Wednesday automatically according to the

schedule within the effective time range.

® Thursday: The plan will be played every Thursday automatically according to the schedule

within the effective time range.

® Friday: The plan will be played every Friday automatically according to the schedule within

the effective time range.

® Saturday: The plan will be played every Saturday automatically according to the schedule

within the effective time range.

® Sunday: The plan will be played every Sunday automatically according to the schedule within

the effective time range.
Step 10 Set the action after the program stops. The options include FTB and Current Frame.

® FTB: After the program playback ends or the playback time reaches the end time, the output

image fades to black.

® Current Frame: FTB: After the program playback ends or the playback time reaches the end

time, the output image displays the frame when the program stops.
Step 11 Repeat steps Step 4 to Step 10 to add more plans under the current task.
Step 12 Repeat steps Step 2 to Step 10 to add more tasks and plans.

Step 13 Click OK to finalize the program scheduling.

Step 14 Go to
enable scheduled playback.

> Enable Scheduled Playback in the bottom right corner of the main interface to

E Note

o Different plans cannot have the overlapping time slots.

o Different tasks cannot have the overlapping time slots.

Insert Program

Once the scheduled playback is activated, it supports the program insertion. This insertion can

be executed either immediately or with a delay.
® Immediate Insert: Play the next selected program instantly.

® Delayed Insert: Wait for the current program to finish before playing the selected program.

Step 1 Navigate to > Edit Scheduled Playback from the bottom right of the main interface to

open the scheduled playback window.
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Figure 5-61 Edit scheduled playbacks
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Step 2 Click the program name next to the plan that requires insertion to open the program selection
window.

Figure 5-62 Select programs

Scheduled Playback i English v X

New Task
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Step 3 Right click the desired program name in Plan List and select either Inmediate Insert or Delay
Insert to proceed with the program insertion.
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Figure 5-63 Insert programs
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Rules for program insertion:

® Only programs that are currently being played or have not yet begun support program

insertion. The programs that have already been played do not support insertion.

® For a schedule plan that is being played, the insertion can alter the order of the program

sequence.

® |f an insertion spans different plans, after the insertion, the playback will switch to the plan

that contains the inserted program and continue until the end of the new plan.

® |f an insertion spans different tasks, after the insertion, the inserted task will play first; once

completed, the playback will revert back to the pre-insertion plan and continue.

Other Operations

® Delete plans

® |n the Scheduled Playback window, click @ next to the desired plan to delete the plan.

® Delete tasks

-

In the Scheduled Playback window, click [[U next to the desired task to delete the task.
® Edit plans
Click E at the desktop taskbar to open the Scheduled Playback window and then add,
edit or delete the desired plans or tasks.
® Create task copies

Click located on the right side of the task to quickly create a task copy. By expanding

the copied task, you will be able to modify the related information.
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® Create plan copies

Click located on the right side of the plan to quickly create a plan copy. By expanding

the copied plan, you will be able to modify the related information.

® Disable scheduled playbacks

Go to > Disable Scheduled Playback in the bottom right corner of the main interface
to halt the scheduled playback.

5.5 Save Projects

You can save the project when you are satisfied with the project settings for easy use in future.
Go to Project > Save or Save As to save the current project file to your local storage.

The project file includes the following information:

® Media files

® Qutput editing settings

® Programs and all layers in the programs

5.6 Package Projects
You can save the edited project and the imported media files as an independent project file for
easy and convenient use on any computers in the future.

Step 1 Go to Project > Package Project.

Step 2 Enter the project file name, and select the save location and desired files in the displayed

window.

Figure 5-64 Package projects

FProject Name New Project 1 01-06_14-38

Select Save Path C:/Users/Admin/Desktop
Select Packaze File O Used ® All

Project Size 1.41 X

Package
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® Used: The media files that have been imported to the media library and added into the

programs

® All: All the media files that have been imported to the media library

Step 3 Click Package.
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6 Link

6.1 Link Settings

Application Scenarios

® Kompass FX3 supports the primary and backup outputs. If the primary device fails or the
cable connection of the primary device breaks, the backup device will take the

responsibilities of the primary device seamlessly to ensure the output will not go black.

® Kompass FX3 supports the master and slave outputs. If the master device cannot load the
screen independently, one or multiple slave devices can help load the screen. You can
configure the master and slave outputs on the master device to manage the playback

images on the screen.

Figure 6-1 Applications
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Prerequisites

® The primary and backup devices or the master and slave devices must be on the same

network segment.

® The sync card must be installed into the master and slave devices.
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Operating Procedure

Step 1 In the Kompass FX3 of the primary device, go to Link > Link Settings to open the link settings

window.

The system will automatically search for the IP addresses of the devices where Kompass FX3 is
enabled on the current network segment, and then show the IP addresses in the Device List

area.

Figure 6-2 Link settings

Local/Master
172.16.15.201

Step 2 Add a backup device.

1. Inthe Device List area, select the IP address of the device that you want to add as a backup

device.
2. Click and drag the selected IP address to the device on the right side as shown in the
following figure.

Step 3 Add a slave device.

1. Inthe Device List area, select the IP address of the device that you want to add as a slave

device.

2. Click and drag the selected IP address to the blank area on the right side as shown in the

following figure.

You can also add a backup device to the slave device. At this time, this slave device serves as

the primary in its own primary and backup relation.
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Figure 6-3 Add backup or slave devices

Backup
172.16.154

172161519

Step 4 Manage the backup or slave device.

1. In the topology, select the backup or slave device.
2. Right click the device to open the context menu.

- Connect: If the primary and backup connection or the master and slave connection fails,

select this option to manually connect the devices.
- Delete: Break the primary and backup connection or the master and slave connection.
- Power On: Power on the backup or slave device remotely.
- Power Off: Power off the backup or slave device remotely.

- Restart: Restart the software on the backup or slave device.

E Note

¢ Right click Local/Master to show the context menu and select Disconnect All Links to

disconnect all the linked devices.

e Right click Local/Master to show the context menu and select Remote Power On/Off to set
the desired power on time and power off time of the linked device. Before you set the
remote power on/off time, make sure you have enabled the auto power on/off function in
the BIOS menu of the linked device.

Step 5 Click OK to complete the backup or slave device settings.
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6.2 Update to Backup

In the Kompass FX3 of the primary device, go to Link > Update to Backup to manually update

all the data on the primary device to the backup device.

On the main user interface, click Update on the top right to view the updating progress, i.e., the

media transmission progress, as shown below.

Figure 6-4 Update progress

1 (IE3 N 0 N G ( Live Pre-Edit Properties

< B |Screen0i Screen 02 Screen 03 > D 172.16.15.4(1600579-p)

6.3 Update to Slave

Manually update all the data on the master device to the slave device.
Step 1 In Kompass FX3 of the master device, go to Link > Update to Slave.
Step 2 Select the desired slave device from the window that appears.

Figure 6-5 Update to slave

p
17216154

Step 3 Click OK.
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On the main user interface, click Update on the top right to view the updating progress, i.e., the
media transmission progress. If the slave device has a backup device, the Update to Slave

action will also update the backup device data simultaneously.

6.4 Disconnect

In the Kompass FX3 of the backup or slave device, go to Link > Disconnect to break the
connection between the primary and backup devices or the connection between the master and

slave devices.
® |n the Kompass FX3 of the primary or master device, this option is greyed out.

® In the Kompass FX3 of the primary or master device, go to Link > Link Settings to break the
binding relation between the primary and backup devices or between the master and slave

devices in the topology.
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7 Settings

7.1 System Settings

Set the startup-related settings. Go to Settings > System Settings to open the System
Settings window.

Figure 7-1 System settings

System Settings

Auto start after power on

Open recent project after startup

Playback logs (excluding scheduled playbacks)
Play project after opened |Last Time -
Auto save project |5 > min

lilegal content recognition

Close Button Close program Minimize to tray

Auto Restart Schedule the restart

Adapter |G1(Intel(R) Iris(R) Xe Grapl v | Take effect after restart
Log Storage Duration | Fgrever
Storage Path  D:/Playlog

Free Space 81.3GB

Cache Path  D:/Media Browse

Free Space 81.3 GB

Shared Folder Path  D:/SharedFolder

Free Space 81.3 GB

Cloud Media Path  D:/CloudMaterial

Free Space 81.3 GB

® Auto start after power on:
- Selected: The software will be started automatically when OS starts.
- Deselected: The software will not be started when OS starts.

® Open recent project after startup:

- Selected: The recently-opened project will be opened when the software starts.
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- Deselected: A new project will be created when the software starts.
® Playback logs: Set whether to record the playback logs.
- Selected: The playback logs will be recorded automatically.

- Deselected: If the scheduled playback is disabled, the playback logs will not be

recorded. If enabled, the playback logs will be recorded.
® Play project after opened:

- Selected with specified program: The specified played project will be played
automatically when the software starts.

Last time: Play the program that was playing in the software before it was last closed.
Program n: Play the specified program when the software starts.

® Deselected: No project will be played when the software starts.

® Auto save project:

- Selected: The project file will be automatically saved according to the set time interval.

The time interval ranges from 1 to 30 minutes and defaults to 5 minutes.

- Deselected: The project file will not be saved automatically and you need to save it

manually.
® |llegal content recognition:

- Selected: Enable the feature. When illegal content is detected, the screen will display
black, but media playback will not be interrupted. Enabling this feature requires the
installation of the illegal content detection plugin, which can be obtained by contacting

the technical support.

- Deselected: The feature is disabled, and the playback screen will display the media

content as is.
® Close Button: The status of the software when you click Close at the top right
- Close Program: You will directly exit the program and no image will be output.

- Minimize to tray: The program will be minimized to tray and the image will be output
normally. Click the program icon in the tray and then the program will be displayed on
your desktop.

® Auto Restart: Schedule the restart time for the software.
- Selected: The software will be restarted automatically according to the set time.

A restart prompt appears 10 seconds before the restart time. You can restart the
software or cancel the restart. If the software runs automatically for a long time, it is

recommended to set the restart time to ensure that the software runs well.
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- Deselected: The software will not be restarted automatically.

® Adapter: Select the adapter for the video rendering in the stage editing area. After the
selection, you must restart the server where the software is installed to apply this

configuration.

® | og Storage Duration: Set the save duration for the playback logs. The supported options
include 1 Month, 3 Months, 6 Months, 12 Months and Forever.

® Storage Path: Select the save location for the playback logs.
- Click Browse to select the desired folder.
- Click Open to open the folder where logs are saved.
- Click Clear to clear the cache of the logs.
® Cache Path: Select the save location for the media files downloaded from the primary device.
- Click Browse to select the desired folder.
- Click Open to open the folder where the files are saved.
- Click Clear to clear the cache of the files.

® Shared Folder Path: Set a shared folder locally and share the folder to other users on the
same network segment. The user can add the media to the folder and the added media will
be automatically displayed in the Media Library area. Add the desired media to the

Program Management area and play it. A remote shared folder can also be added.
- Click Browse to select the shared folder path.

- Click Open to open the shared folder.

- Click Clear to clear the files in the shared folder.

® Cloud Media Path: Set a local folder where the downloaded media from cloud storage will be

automatically saved.
- Click Browse to select the storage location for the cloud media.
- Click Open to open the cloud media folder

—  Click Clear to clear the files in the folder.

E Note

If the media under the shared folder is added to the program and media collections, after you
delete the files under the shared folder path, the media saved in the program and media

collections will also be deleted.
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7.2 Output Settings

Set the program transition effect, transition duration, as well as the FTB status and duration.

Go to Settings > Output Settings to open the Output Settings window.

Figure 7-2 Output settings
Qutput Settings

Mute FTB

MFPS EFPS

FTB Duration

Program Transition |Fade v 0.50

After Program Ends  |Loop Playback ~

Default Duration  |Picture v 00:10:00:000
After Media Starts | Play v
Office Type  |Default
Playback |PowerPoint

Animation Picture

PowerPoint Resolution  |1920%1080 v

Frame Sync Mode |Mode 2 v 100000

® Mute FTB: Set whether to turn off the audio during the FTB process.
- Selected: The audio will be turned off.
- Deselected: The audio will be output as normal.

® MFPS/EFPS: The real-time frame rate

- MFPS: After checked, the real-time frame rate will be displayed at the bottom left of the

preview window.

- EFPS: After checked, the real-time frame rate will be displayed at the bottom left of the

output image.
® HDR: Set whether to support the HDR rendering.

- Selected: The HDR rendering is supported. When the HDR rendering is performed, you

need to enable HDR10 below the stage editing area or in the output adding window.

- Deselected: The HDR rendering is not supported.
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E Note

Only 10th generation Intel CPUs or later support HDR functionality.

FTB Duration: Set the time length the FTB process lasts. The value range is 0.00 to 10.00s
and it defaults to 0.50s.

® Program Transition: Set the program transition effect. The options include Fade and Cut.

® Transition Duration: Set the time length the fade effect lasts. When Program Transition is

set to Fade, this option is available. The value range is 0.00 to 10.00s and it defaults to 0.50s.

® After Program Ends: Set the default playback action after the newly-added program stops

playing. The setting here does not affect the existing programs.
- Loop Playback: The newly-added program will be played circularly.

- Jump to Next: When the newly-added program stops playing, the first program on its
right will be played.

- Stop Playing: When the playback of the newly-added program ends, the playing will be
stopped.

® Default Duration: Select the desired media type, and then set the default playback duration

for the media of the selected type.
® After Media Starts: Set the state of the media at the commencement of playback.

- Play: The media transitions to normal playback mode immediately upon the start of the

program.

- Hold on First Frame: The media freezes on the initial frame upon the start of the

program. To continue playback, click D next to the media name in the Playback tab
on the right pane.

® Office Type: Select the application program that will be used to open the PowerPoint or

Excel files.

- Default: The PowerPoint or Excel files will be opened in the default tool of your media

server.
- Microsoft Office: The PowerPoint or Excel files will be opened in Microsoft Office.
- WPS Office: The PowerPoint or Excel files will be opened in WPS Office.
® Playback: Set the playback mode for the PowerPoint or Excel files.
- Animation:

For the PowerPoint files, the animation effects will be shown during the slide switching.
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For the Excel files, one can navigate between columns and rows by means of page
flipping.
WPS Office does not support this mode.

- Picture: The files are shown and switched as pictures.

- Native: The default mode of Excel, exclusively supported by Excel, allows for switching

between rows, columns, and sheet pages.
® PowerPoint Resolution: Select the desired output resolution of the PowerPoint file.

® Frame Sync Mode: Ensures video signal frame synchronization during transmission,

supporting three modes.

- Mode 1 and mode 2 are for frame sync settings of multiple graphics card configuration,

while mode 3 is for frame sync settings of multiple devices.

- Mode 1 and mode 2 involve setting the number of calibrations after program switching.
Mode 2 defaults to 5 calibrations.

- Mode 3 defaults to 100000 calibrations, with continuous frame sync calibration after

program switching.

7.3 Multiple Displays

When two or mode displays are connected, you can set to duplicate the desktop or set to show
different content on each display, that is, extend mode. Go to Settings > Multiple Displays to

select the desired mode.
® Duplicate: All the connected displays output the same content.

® Extend: The connected displays output the different contents. The extend mode is the

default option.

7.4 External Control

Kompass FX3 supports remote control and control via a control device, allowing users to
manage the software conveniently. For details on the commands and command writing rules of
remote controlling and controlling via a control device, please see Control Protoco/ of NovaStar

Playback and Control Software.

Go to Settings > External Control to open the External Control window.
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Figure 7-3 External control
External Control
Serial Port

UDP

Port 19958 > [ usten |

TCP/IP

Port 19958 2| [ Listen |

7.4.1 Control via Network

For control via a network, Kompass FX3 supports remote control via UDP and TCP/IP protocols.

Go to Settings > External Control to open the External Control window.

Control via UDP Protocol

Step 1 Select UDP to enable UDP control.
Step 2 In the text box next to Port, enter the UDP port number of Kompass FX3.
The UDP port number ranges from 1024 to 65535 and defaults to 19958.
Step 3 Click Listen. The software will automatically check whether the port number is occupied.

® Occupied: Re-enter a port number and click Listen again to check.

® Not occupied: The UDP control settings are completed.

Control via TCP/IP Protocol

Step 1 Select TCP/IP to enable TCP/IP control.
Step 2 In the text box next to Port, enter the TCP/IP port number of Kompass FX3.
The TCP/IP port number ranges from 1024 to 65535 and defaults to 19958.
Step 3 Click Listen. The software will automatically check whether the port number is occupied.

® Occupied: Re-enter a port number and click Listen again to check.
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® Not occupied: The TCP/IP control settings are completed.

7.4.2 Control via Serial Port

To control Kompass FX3 via serial port, use a serial cable to connect the control device to the

computer where Kompass FX3 is installed.

Step 1 Go to Settings > External Control > Serial Port.

Figure 7-4 Serial port control

Network
Serial Port
Baud Rate

Data Bits

Parity

Stop Bits

External Control

115200
8

-
1 -

Close Port Open Port

Close

Step 2 Click Scan. The system will automatically scan the serial ports of the computer.

Step 3 Click the drop-down box next to Serial Port and select the serial port currently connected to

the control device.

Step 4 Set Baud Rate, Data Bits, Parity, and Stop Bits.

E Note

The parameter values of baud rate, data bits, parity and stop bits of the serial port on the

control device must be the same as the values of those parameters you set in Kompass FX3.

Step 5 Click Open Port to finish serial port settings.

Step 6 Click Close to close the window.

7.4.3 Control via App

Kompass FX3 can be controlled via VICP (Visual Intelligent Control Platform). The connections

for app control are as follows.
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Figure 7-5 Connections for app control

I l Router

Kompass FX3
Media Server

Connection Requirements

The media server, video wall splicer and pad (with app installed) must be on the same network

segment.

Media Server Configuration

® Obtain the IP address of the media server.

1) On the media server, press Win and R keys simultaneously to open the Run command

dialog window.

Figure 7-6 Run command window

¥ Run X

Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you,

Open: v]

0K Cancel Browse...

2) Type "emd" in the search box and then press Enter to open the command prompt.

3) Type "ipconfig" and then press Enter to show the device IP address.
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Figure 7-7 Obtain the IP address of the media server

94:bf0:417 1:b6d%6

nistrator>

IPv4 address indicates the IP address of the media server.
® Configure the listening port of the media server.

1) Run Kompass FX3 and then go to Settings > External Control to open the external

control settings window.
2) Select the Network tab.
3) Check the box in front of TCP/IP to enable the TCP/IP control.
4) Enter the port number in the text box next to Port.
5) Click Listen to enable the listening for the external control.

If the port is occupied, a prompt saying "Listening failed: The port is being used." is

shown. You must re-enter a port number and click Listen again.

If a prompt saying "Listening succeeded." is shown, the listening succeeds and the

Listen button is highlighted. Click OK to complete the settings.

6) Click Close to complete the port settings.

E Note

When you use the App for device control, please refer to the App user manual for operation

details.

7.5 Audio Settings

You can configure the correspondent relations between the sound cards and sound channel

mappings. One sound card corresponds to one mapping only.

For example, if you select Map 01 for the layer media A, B and C at the same time, the audio
information in these three media will be output via the sound card that Map 01 corresponds to.
If you want to change the sound card for these three media, you only need to change the sound

card that Map 01 corresponds to rather than set the sound card for each media respectively.
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Figure 7-8 Audio settings

Audio Settings
Select Track to Play (Take effect after restart

Map01 | Local/LG FULL HD (HD Audio Driver for D ¥| Count |Default v

Map02 | [N/A v| Count

Map03 |N/A ¥| Count

OK Cancel

® Select Track to Play: When the backend audio device is an Atmos device, you need to check

this option. After setting, restart the software for it to take effect.

- Checked: In program management, choose the media, and navigate to Properties >
Sound Channel Mapping > Select Track to Play to choose the track. Once selected,

non-Dolby audio media will not output audio.

- Unchecked: No need to choose the track, audio outputs directly. At this time, Dolby
audio media will not output normally to the backend Atmos device.

® Three mappings are displayed by default.

You can click New at the top right to add a new mapping, and click the channel mapping

name on the left to modify it as required.
® The drop-down list shows all the sound card devices of the device.

Kompass FX3 supports the hot swapping of the sound card device and you do not need to

restart the software after a new sound card is installed.

® Configure the sound channel count for the mapping. The supported options include Default,
2,4, 6 and 8.

Default indicates the sound channel count of the corresponding sound card.
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8

Help

8.1 Transcoding and Encryption Assistant

Step 1

Step 2

Step 3
Step 4

Step 5

Kompass FX3 supports the conversion of the video coding format, code rate, resolution and
frame rate, as well as the encryption of videos, to satisfy the requirements of different playback

scenarios.
Go to Help > Transcoding and Encryption Assistant.

Figure 8-1 Transcoding and encryption assistant

Transcoding and Encryption Assistant

mport Path Encoding Format  Frame rate  Resolution  Duration Progress

Save To |C/Users/Nova001395/AppData

| Open \ |\'.’hange.\

Coding |Self-Adaptive

elf-Adaptin ¥

Frame elf-Adaptiv = Fps

1920 2| O H:

Resolution W:

1080 _

Audio |Keep

Add Delete Transcode

Click Add at the bottom to open the local folder where you can select the desired video or
image file.

You can also add multiple files by pressing the Ctrl key and selecting the files simultaneously.

Select the file and directly drag it to the file list area to swiftly add the video and image files.
Click Select File to add them into the assistant.
Select the target file for transcoding.

Set the parameters of Coding, Quality, Code Rate, Frame Rate, Resolution and Audio and

more as required.
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® Coding: Set the coding format of the transcoded video. The supported options include
Adaptive, h264, h265, VP9 and hap.

When Self-Adaptive is selected, the video will be transcoded according to the original video

coding.

® Keep HDR: Set whether to retain HDR in the converted video. When the Self-Adaptive,
H264, and H265 coding option is selected, this item is available.

- Selected: The converted video retains the HDR of the original video.

- Deselected: The original video's HDR is not retained, and the converted video will be in
SDR format.

® Keep Alpha Channel: Set whether to train the original alpha channel for the HAP videos.
- Selected: Retain the alpha channel information for the HAP video.

- Deselected: Do not retain the alpha channel information and the system will

automatically fill in the alpha channel.
® Copyright: Encrypt the selected video, making it playable only in Kompass FX3.

- Select Copyright (encrypted. nvf): Enable video encryption and convert the video file
to the .nvf encrypted one.

- Password: Set a password for the encrypted video.

- Auth Expire: Set the authorization duration for the encrypted video. The value ranges
from 1 to 999. Once the authorization duration is exceeded, the encrypted videos will

show as Expired in the media library.

Table 8-1 Copyright description

Password Auth Expire Description

Empty Empty The video is .nvf encrypted, but can be played directly

without password decryption.

Non-empty Empty The video is .nvf encrypted, and requires password

decryption in the media library to play.

Empty Non-empty The video is .nvf encrypted within the authorization
duration, but can be played directly without password
decryption.

Non-empty Non-empty The video is .nvf encrypted within the authorization

duration, and requires password decryption in the media

library to play.

® Quality: Set the quality of the transcoded video. The supported options include Low,
Medium and High.
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Step 6

Step 7

Step 8

- High: Keep the quality of the transcoded video the same as the original video quality.

- Low: The quality of the transcoded video is relatively blurred compared to the original
video quality.

- Medium: The quality of the transcoded video is between the high and low qualities.

Code Rate: Set the code rate of the transcoded video. The supported options include Self-
Adaptive and Custom.

- Adaptive: The code rates before and after the transcoding are the same.

- Custom: Set the desired code rate and the video will be transcoded according to the set

value.

Frame Rate: Set the frame rate of the transcoded video. The supported options include Self-
Adaptive, 24, 30, 60 and Custom.

- Adaptive: The frame rates before and after the transcoding are the same.

- 24/30/60: The frame rate after the transcoding will be 24 Hz, 30 Hz, and 60 Hz,

respectively.

- Custom: Set the desired frame rate and the video will be transcoded according to the

set value.
Resolution: Set the resolution of the transcoded video.

- W: Set the horizontal size of the transcoded video. The value defaults to 1920 and can

reach a maximum value of 8192 (recommended).

- H: Set the vertical size of the transcoded video. The value defaults to 1080 and can

reach a maximum value of 8192 (recommended).

Audio: Set how to deal with the audio that comes with the video. The supported options

include Keep and Remove.
- Keep: The transcoded video retains the audio in the video before transcoding.

- Remove: The transcoded video displays pure images without any audio.

Repeat the above steps to set the transcoding parameters for other video files.
Click Transcode and the system will automatically start the transcoding process.

When the progress reaches 100% in the Progress column, the transcoding completes. After the

transcoding, the video will be saved in the path specified in Save Path.
Click Open to open the local folder where you can view the transcoded files.

® Click Change to change the save path.

® (Click Delete at the bottom to delete the selected video files.
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E Note

The transcoding and encryption assistant and play log windows do not automatically close with

the main user interface and require manual shutdown.

8.2 Logs

Kompass FX3 supports the automatic statistics of the playback logs. When you select a certain
date, time period or media name, you can search for the desired logs. The log information

includes the number, media name, start time, end time, total duration and playback times.
Step 1 Go to Help > Play Log to open the playback log window.

Figure 8-2 Logs

Play Log

Search

Media Name Start Time

Step 2 Click Date and select the desired time period. The supported options include Today, Recent 7
Days, Recent 1 Month and Recent 3 Months.

E Note

Before you use this function, please set the value range of Log Storage greater than the time

period range you set here.

Step 3 Set the start and end time.

Step 4 Enter the media file name in the text box next to Media Name to search for the payback logs of

this single media, otherwise the playback logs of all media files will be searched and displayed.

Step 5 Click Search to start the searching.
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Figure 8-3 Media playback logs

Play Log j&=/Language: English ¥ X

Date | Today ¥ | From |2024/08/22 00:00:00 - | To 2024/08/22 23:59:59 -
Media Hame Search

Hedia Name

Export

Step 6 Click Export to export the playback logs to your local computer.

8.3 User Manual

On the menu bar, go to Help > User Manual, or press the F1 key on the keyboard to open the

user manual.

8.4 |dentification Code

On the menu bar, go to Help > Identification Code to view the product unique ID code.

8.5 About

On the menu bar, go to Help > About to view the software information.
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9 Language

Switch the software language according to your preference.
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accurate Al chat services to quickly answer questions and offer software operation guidance.
Additionally, it allows users to generate personalized images by entering prompts, selecting
image ratios, and styles. The integrated web search feature enables users to access real-time
internet information, catering to diverse needs.

Prerequisites

® You have completed the software authorization.

® You have logged in the software.

Limitations

® FEach account is limited to 100 Al chat operations and 10 image generation operations per
day.

® Only one image is generated per operation, consuming one image generation count.

Al Chat

Step 1 Click Al Assistant to open the Al Assistant interface.
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Figure 10-1 Al assistant
Al Assistant

Hello, I' m your Al Assistant.
Nice to meet you!

& Generate Image

&Y Deepseek @ Web Search

Step 2 Click Al Chat to select the Al Q&A function.
Step 3 Enter your question in the text box below.

To ensure accurate answers, it is recommended to ask specific, clear, and unambiguous

questions with sufficient context. A maximum of 200 characters is supported.
Step 4 Set the Al thinking mode, supporting DeepSeek and Web Search modes.

® DeepSeek:

- On: If the user’s question is not found in the current product knowledge base, the

system will use the DeepSeek model to provide suggestions.

- Off: If the user’s question is not found in the current product knowledge base, the

system will use the default Nova model to provide suggestions.
® Web Search:

- On: Web search is enabled, and the system will search the internet based on the user’s

question to provide suggestions.

- Off: The system will not perform a web search and will rely on the current product

knowledge base and the selected large model for reasoning.

Step 5 Click Send to let the system process the question and provide an answer.
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Image Generation

Step 1 In the Al Assistant interface, click Generate Image to enable the text-to-image function.

Figure 10-2 Image generation
Al Assistant

Ai+  Hello,I' m your Al Assistant.
Nice to meet you!

1) Al Chat

16:9 ¥ | |Portrait Photography ¥

Step 2 Enter the basic requirements for the image in the text box below.

When using Al to generate images, please provide clear and detailed text descriptions,
including the theme, details, style, emotion, and any specific requirements, to help the Al
accurately understand and create images that meet expectations. A maximum of 200 characters

is supported.
Step 3 Select the desired image aspect ratio from the default 16:9 options.
Step 4 Select the desired image style from the default Portrait Photography options.

Step 5 Click Send to let the system generate an image based on the input text. Only one image is

generated per operation.
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Figure 10-3 Generate images

Al Assistant

Hello, I' m your Al Assistant.
Nice to meet you!

B Al Chat

If generation is not needed, click Stop.

View and Check Images

After the image is generated, hover over the image to display the image tools.

Figure 10-4 View images
Al Assistant

Hello, I' m your Al Assistant.
Nice to meet you!

draw a pi with mountains, rivers, birds, clouds and some animals

e dit

iv Image generated:

B Al Chat

16:9 ~ | |Portrait Photography >
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o G-1: Click to zoom in the image, and click Download Image to Media Library to save the
generated image to the media library.

° i: Click to download the generated image directly to the media library.

VA

® =—: Click to automatically fill the description used to generate the image into the text box
below, allowing for modifications and regeneration.

More Operations

® Copy: Copy the question or Al result.
e Edit: Fill the description used to generate the image into the text box below.
[

Try Again: If no result is received, click Try Again to reattempt the question.

Clear: Clear all information in the dialog box.
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1 1 Graphics Card Mosaic

11.1 Set Main Display

Step 1 Right click on your desktop and select Display settings.

Figure 11-1 Display settings

View >
Sort by >
Refresh

Paste

Paste shortcut

a Intel ® Graphics Settings
[E NVIDIA Control Panel

New >

=1 Display settings
:_l Personalize

Step 2 Select a display to set it as the main display.

Figure 11-2 Multiple displays-1

Display
Rearrange your displays

Salect & display below to change the settings for it Press and hold (or select)
display, then drag to rermange i,

1o set things up.

R Gethelp
’I ! £ Give feedback

Identify Detect

Color

Might light
@ o

Night light settings

Windows HD Color

Giet a brighter and more vibrant picture for videcs, games and apps
that support HOR.

‘Windaws HD Colar seftings

Scale and layout

ChEnge the size of text, apps. and ather items

1005, v

a Note

When multiple displays are connected, you can click Identify to show the number at the bottom
left corner on each display.

Step 3 For the Multiple displays item, select Extend these displays.
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Figure 11-3 Multiple displays-2

find  setting b

Step 4 On the window that appears, select Keep changes.

Display

Windows HD Color

Scale and layout

Change the size of text, apps, and other items

0% Recommended) |

Advanced scaling settings

Display reschstion

1970 x 108D (Recommendsd) v

Display anentatica

Multiple displays

Muitiple displays
Extend these displays v

A Make thic my main dispia

Advanced display settings

Graphics settings

Figure 11-4 Confirmation

Keep these display settings?

Reverting to previous display settings in 12 seconds.

Keep changes

Step 5 Check the box next to Make this my main display.

11.2 Change Resolutions

11.2.1 Set Standard Resolutions

Step 1 Right click on your desktop and select Display settings.

Figure 11-5 Display settings

View
Sort by
Refresh

>
>

Paste

Paste shortcut

a Intel ® Graphics Settings
[E NVIDIA Control Panel

New

1 Display settings

:_1 Personalize

Step 2 Select a display to set it as the main display.
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Figure 11-6 Multiple displays-1

- o =
Display
Rearrange your displays sleep better

Night light can help you get to
Select a display below to change the settings for it Press and hold or select) a e by displaying werenes colors
display, then drag o rearange it at night. Sefect Night ight settings

o sat things Up.

@ et heln
I:Z T

Color

Night iaht
@0 o

Night ight settings

Windows HD Color

Get a brighter and mare vibrant picture for videos, games and apas
that suppart HOR.

Windaws HI Calor settings

Scale and layout

Change the sirs of tei, apps, and ather items

E Note

When multiple displays are connected, you can click Identify to show the number at the bottom

left corner on each display.

Step 3 For the Display resolution item, select the desired output resolution.

Figure 11-7 Multiple displays-2

Display

Windows HD Color

Gt a brighter and more vibrant picture for videos, games and spos
that support HOR.

Windows HD Color sellings

Scale and layout

Change the size of text, apps, and other itemns

Advanced scalfing settings

o
H
%

<

1920 1080 (Recommends<s)

Display onentatica

Landscape

Multiple displays
Muttiple displays
Extend thess displays

D|

Advanced display settings

Graphics settings

Step 4 On the window that appears, select Keep changes.
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Figure 11-8 Confirmation

Keep these display settings?

Reverting to previous display settings in 12 seconds.

Keep changes -

Step 5 Repeat the above steps to complete the resolution settings for other displays.

11.2.2 Set Custom Resolutions

Step 1 Right click on your desktop and select NVIDIA Control Panel.

Figure 11-9 NVIDIA control panel

View >
Sort by >
Refresh

Paste

Paste shortcut

& Intel® Graphics Settings
[ NVIDIA Control Panel

New >

[0 Display settings
&2 Personalize

Step 2 On the NVIDIA Control Panel interface, go to Display > Change resolution.

Figure 11-10 Change resolutions

NVIDIA Control Panel - o X
File Edit Desktop Display Help
O -O | B
Select 3 Task. B ~
S [ 731 Change Resolution
Adjust image settings with preview = [=EE0E D
Manage 3D settings You can adjust the amount of i the screen You can also definition (HD) format i you are u|
‘Set PhysX Configuration ‘country-specffic signal for your standard-definition (SD) TV.
Display
settings 1.Select the display you would like to change.
View HDCP status
Setup digital audio
Adyust desktop sizz and positon L
Setup multiple displays LG Electronics LG. LG Electronics LG.
& Ster » (1of2) (20f2)
Setup stereoscopic 3D
View rating for games
2. Choose the resolution.
Connector:
= HoM-HOTY
w system topology
Set up Mosaic Resolution: Refreshrate:
Manage GPU Utilization
Ultra HD, HD, 5D ~ S0Hz. v
1080, 1920 x 1080 (naiive)
1080, 1920 1080
1080, 1768 x 582
720, 1280 % 720
7200, 1176 664
$76p, 720 % 576
4800. 720 x 480 v
3. Apply the following settings.
oL settings
[ system tnformation (80150 WA ol settins v
< >

Step 3 Select the desired display.

Step 4 Click Customize to show the customize window.
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Figure 11-11 Custom resolution-1

Customize =

|n Select the resolutions that you want to add. You can areate a custom resolution for a display
| | that may not use a standard Windows resolution. Mote that applying these resolutions may
resultin a temporary blank display.

Resolutions:

Click Create Custom Resolution to add items.

[ Enable resolutions not exposed by the display

Create Custom Resolution...

Cance

Step 5 Click Create Custom Resolution.

Step 6 Read the disclaimer information carefully and click Accept to show the Create Custom

Resolution window.

Step 7 Select the desired display.
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Step 8

Step ¢

Figure 11-12 Custom resolution-2

%ﬁ Test successful. Custom resclutien 1920 x 1080 at 50Hz

|
|ul Create a resolution that is not currently available in Windows., Your display may flicker a
=== few times when testing a new custom resolution.

1. Select displays: Identify displays

[] Display D Current resolution
Quadro K620

LG Electronics LG FULL HD (1 of 2) 1920 x 1080 at 50Hz (32-bit)
[0 L& Electronics LG FULL HD {2 of 2) Ed 1920 x 1080 at 50Hz (320i1)

2. Resolution settings:

Import settings
Display mode (as reported by Windows)
Horizontal pixels: 1920 |5 Vertical lines: 1080 [
Refresh rate (Hz): 50 = Color depth (bpp): |32 v
Scan type: Progressive e
4 Timing
Standard: CVT reduced blank ~
Horizontal Vertical

Active pixels: 1920 = 1080 =

Front porch (pixels): 48 = 3 o

Sync width {pixels): 32 = 5 =

Total pixels: 2080 = 1106 =

Polarity: Positive (+) Megative (-)

Pixel dock:
Refresh rate: 55.30 KHz 50,000 | Hz 115.0240 MHz
(48.000 to 51.000)
Test Cancel

Click Test and then click Yes on the window that appears.

Figure 11-13 Confirmation

nply Changes >

(32-bit) has been applied.

Do wou want to save this resolution for all szelected
dizplays?

Reverting in 6 seconds Yes (Y} Ne (N}

¥

Set the horizontal pixels, vertical lines, refresh rate and scan type.
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Figure 11-14 Custom resolution-3

Customize >

|n Select the resolutions that you want to add. You can create a custom resolution for a display
|El  that may not use a standard Windows resolution. Note that applying these resolutions may
resultin a temporary blank display.

Resolutions:

Click Create Custom Resolution to add items.

Enable resolutions not exposed by the display

| Create Custom Resolution... |

oK Cancel

Step 10 Click OK to complete the custom resolution settings.

After a custom resolution is created successfully, it will appear in the custom area as shown in

the figure below.

Figure 11-15 Custom resolution-4

NVIDIA Control Panel - [u] X
File Edit Desktop Display Help

Qus -@ |G

selectaTask..,

Ep [[ﬁ; Change Resolution
Adjust image setings with preview == estorsiDeraulrs
Manage 3D settings “You can adjust the amount of inf the screen You can also {HD) format if you are u
Set PhysX Configuration ‘country-speciic signal for your standard-definition (SD) TV.

Display
‘Adjust desktop color settings 1. Select the display you would like to change.
Rotate display
iew OGP st
Setup digital audio
-Adjust desktop size and position -
Setup multple displays LG Electronics LG. LG Electronics LG.

Stereoscopic 3D (10f2) Qof2)
Setupstereoscoic 0
View rating for games

Video 2. Choose the resolution.
Adijust video color settings
Adjust videa image settings Connector:

& Workstation = HOMI-HDTV

View system topology
Set up Mosaic Resolution: Refreshrate:

Manage GPU Utiization
Ultra HD, HD, SD A [soHz -

1080p, 1920 x 1080 (native)

10801, 1920 x 1080
10801, 1768 * 992
720p, 1280 % 720
720p, 1176 % 664
576p, 720 % 576
4800, 720 % 480

3. Apply the following settings.

O Use default color settings

@ ssten formaton ) ce WD ol setine v
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11.3 EDID Management

After the display resolution settings, you need to manage the EDID for precise identification of

display properties and to avoid the on-site screen display disorder.
Load EDID

The procedure of how to load the EDID is as follows.

Step 1 Right click on your desktop and select NVIDIA Control Panel.

Figure 11-16 NVIDIA control panel

View >
Sort by >
Refresh

Paste
Paste shortcut

Intel® Graphics Settings
P g
[E NVIDIA Control Panel

New >

[C1 Display settings
&2 Personalize

Step 2 On the NVIDIA Control Panel interface, go to Workstation > View system topology.

Figure 11-17 NVIDIA control panel

Iﬂ—:;ll View System Topology

Thpegs e s chukes o pecics s v nton o s

[~ R N
D Pt Mt D Cerbng (i)

Step 3 Click EDID (Monitor) next to a desired output connector of the current graphics card to show
the EDID management window.
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Step 4
Step 5
Step 6

Step 7

Figure 11-18 EDID (Monitor)

B wios

e Edt Desktop Workstaton Help
Qs -O | &
Select 8 Tok. =
e ’ ‘_jl_vmsymmTopolqy
- s T page s the deplays and gchcs cara cornacied wehe e sysen
Oty
© feben
ioro
_— " 3840 x 1080 pinel w
e e oy
etting
as2s
o
. Quadro P2000 (1 of 2
DisplayPort (4
05 Screen Identifier
= Quadro RTX 5000 @ of 2
[~ pomp— DisplayPort (4 Not connected
Mors stied
Figure 11-19 Manage EDID
Manage EDID X
Export Load  Unload
Select Connector to Export EDID:
Connector Display Status Video signal
Quadre P2000(1)
DisplayPort (1) Mot Connected  VGA (Analog)
DisplayPort (2) NotConnected  VGA (Analog)
HOMI LG Electronics LG FUL...  Monitor DisplayPort (Digital)
DisplayPort (4) Mot Connected ~ VGA (Analog)
Quadro RTX 5000(2)
HOMI DP1.2 (20f3) Manitor DisplayPort (Digital)
HDMI DP1.2(30f3) Monitor DisplayPort (Digital)
HDMI DP1.2(10f3) Monitor DisplayPort (Digital)
Use-C LG Electronics LG FUL...  Monitor DisplayPort (Digital)
DisplayPort (4) Mot Connected  VGA (Analog)
Export EDID Cancel

Click Export EDID and then name the exported EDID file in the window that appears.

Select the Load tab to show the EDID loading window.

Click Browse and then select the EDID file exported in Step 4.

In the Select Connector to force EDID area, select the desired connector.
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Figure 11-20 Load EDID

Manage EDID x
Export Load  Unload
EDID file:
| | E Browse i
Select Connector to force EDID:
T Connector Display Status Video signal Comments® [l
Quadre P2000(1)
DisplayPort (1) Mot Connected  VGA {Analog)
DisplayPort (2) Mot Connected  VGA (Analog)
HOML LG Electro...  Monitor DisplayPort (Dig...
DisplayPort (4) Mot Connected  VGA (Analog)
Quadro RTX 5000(2)
HOML DP1.2(20... Monitor DisplayPort (Dig...
HDMI DPL2(3 Manitor DisplayPort (Dig. ..
HOMI DP1.2(lo... Monitor DisplayPort (Dig...
1eo - Lot i et e e
< >
= [ ]I have read the warning messages and want to load EDID on selected monitors
Load EDID Cancel

Step 8 Click Load EDID.
Step 9 On the dialog box that appears, click OK to complete loading the EDID.

Figure 11-21 EDID loaded successfully

] Chusers\AdministratonDesktopy1.bet EDID successfully loaded.
:

Step 10 Go back to Workstation > View system topology to check the EDID status. If the original EDID
(Monitor) changes to EDID (File), the EDID is loaded successfully.

Figure 11-22 EDID loaded successfully

B NVIDiA Co
Ele Edt Do
Seecta Tosk.
Dsenes
- e
tatus Seting
w25
a
o
a
al
aplayp
a
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Unload EDID

The procedure of how to unload the EDID is as follows.

Step 1 On the NVIDIA Control Panel interface, go to Workstation > View system topology.

Step 2 Click EDID (File) to show the EDID management window.

Figure 11-23 EDID (File)

Step 3 Select the Unload tab and then select the desired connectors.

Figure 11-24 Unload EDID

Manage EDID x

Export Load  Unload

Select Connector to Unload EDID:

7 Connector Display Status video signal
Quadro P2000(1)
DisplayPort (1) Mot Connected  VGA (Analog)
DisplayPort (2) Mot Connected A (A
HDMI LG Electronics ... Monitor
DisplayPort (4) Mot Connected  VGA (Analog)

Quadro RTX 5000(2)

HOMI DPL.2(20f3)  Monitor DisplayPort (Digital)
HOML DP1.2 (30f3) Monitor DisplayPort (Digital)
HDMI DPL2(10f3) Monitor I rt (Digital)
USB-C LG Electronics ... Monitor DisplayPort (Digital)
DisplayPort (4) Mot Connected  VGA {Analog)
Unload EDID Cancel

Step 4 Click Unload EDID.

Step 5 After the EDID is unloaded successfully, click OK on the dialog box that appears.
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Figure 11-25 EDID unloaded successfully

ped

| EDID successfully unloaded

Step 6 Go back to Workstation > View system topology to check the EDID status. If the EDID (File)
changes to EDID (Monitor), the EDID is unloaded successfully.

11.4 Output Mosaic

The graphics card supports connector mosaic output. The output connector mosaic must

observe the following rules.

® The graphics card does not support irregular mosaic layouts. The mosaic layout must be 1x2,
1x3, 1x4, 2x2, 2x1, 3x1 or 4x1.

® The output resolutions of the graphics card connectors that are used for mosaic must be the

same.

Step 1 Right click on your desktop and select NVIDIA Control Panel.

Figure 11-26 NVIDIA control panel

-_View >

Sort by >
Refresh

Paste

Paste shortcut

& Intel® Graphics Settings
[E NvIDIA Control Panel

New >

l 1 Display settings
& Personalize

Step 2 On the NVIDIA Control Panel interface, go to Workstation > Set up Mosaic.
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Figure 11-27 Set up mosaic

B NviDIA Co
He Edit D

Q) rack

Sehectz Tagk..

lﬂ_—ﬂ Set Up Mosaic

= deplays and G7Us, & velebie to cme & snarkes mage.

ﬁ Craste new conficuration

sdenty cepays

B sy Copabbty Informaton

GPUf Dspays e capantty
Qg -

115 Sectronics LEFLLLHD
P »

2012
20002
a0z
5.5 Bectronics LGFLLLKD

‘Condtona 1o set g e
+ A chsplays st haye 2t least one displey trng {ncudng sl schanoed tmng oarameters] n common.
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Step 3 Click Create new configuration to show the mosaic settings window.

Figure 11-28 Mosaic settings

B NVIDIA Mosaic set up - [m] X

| Mosaic Displays Topology: 1% 2

_ 2, Select displays | 3. Arrange dispiays | 4, Adijust overlap and bezel correction

Number of displays: Configuration Name
P Mosaic setup

Topology (rows x columns):
1x2 ~

Orientation of displays:

Landscape ~
() Maximum GPU Topalogy

(®) Minimum GPU Topelogy

[0  1am using recommended connections for the selected topology.

Enable Mosaic

Selected topalogy:

Step 4 Select the screen number from the drop-down list of Number of displays.
Step 5 Select the screen mosaic layout from the drop-down list of Topology (rows x columns).
Step 6 Select the screen orientation from the drop-down list of Orientation of displays.

Step 7 Click Next to proceed.
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Figure 11-29 Select displays

WY NVIDIA Mosaic set up [} x

| Mosaic Displays Topology: 1% 2

1. Select topology _ 3. Arrange displays | 4, Adjust overlap and bezel correction

Displays for Mosaic: (2 selected)

Refresh rate:
¥ Displays Sync capability
60.00 Hz ~
Quadra P2000 L)
[]1. LG Electronics LG FULL HD e P R
1920 x 1080 ~
quadro T 5000 -
2 or12 Total resolution:
3. op1.2 3840 x 1080 pixels
4.DP1.2
g Q 2 displays are selected for Mosaic with sync.
(5. L6 Blectronics LG FULL HD Go to next step to provide information about your display
arrangement.
Selected display sources:

Step 8 Select the connected displays and then select their refresh rate and resolution.
Step 9 Click Next to proceed.

Figure 11-30 Arrange displays

B NVIDIA Mosaic set up

| Mosaic Displays Topology: 1% 2

L. Select topology | 2. Select displays | [EAMeNgESRYSY 2 Adiust overlap and bezel carrection

Avalable display sources:

Topology:

Total Resolution: 3840 x 1080 pixels

Back Next Finish

Step 10 Arrange the displays according to the screen arrangement and structure by dragging the
available displays to the corresponding topology areas.
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Figure 11-31 Arrange displays

[B7 NVIDIA Mosaic set up

| Mosaic Displays Topology: 1x 2

1. Select topology | 2. Select displays _ 4. Adjust overlap and bezel correction

I

‘y Display arrangement for Mosaic is complete. To enable Mosaic, dick 'Apply'.

Topology:

Total Resolution: 3340 x 1080 pixels

Step 11 Click Apply and then click Yes on the confirmation window.

Step 12 Click Next to proceed.

Figure 11-32 Adjust overlap and bezel correction

B NVIDIA Mosaic set up

| Mosaic Displays Topology: 1x 2

1 s e | s s | 5. rorge s | RS EBRERER

Select haw overlap/bezel correction is applied

Use the same setting for all vertical or horizontal edges |

Select edges for overlap/bezel correction

Total resolution: 3840 x 1080 pixels

Enter overlap/bezel correction values for selected edges:
Edges Correction type Correction value (pixels)

v

< >

You can perform overlapping adjustment or bezel correction to the vertical or horizontal edges
of the display as needed.

1. Select whether to use the same settings for all the vertical or horizontal edges of the display

in the Select how overlap/bezel correction is applied area.
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2. Select the desired edges and then enter the overlap or bezel correction values for the
selected edges. Click Apply after the settings are done.

Step 13 Click Finish to complete the mosaic settings.

Figure 11-33 Mosaic completed

B NVIDIA Control Panel
Fle Edit Desktop Workstation Help
Qo -6

Select a Task.

5 0 Setings LEJ! Set Up Mosaic g

Adjust mage settings with preview

Manage 3D settings Mosaic technology creates a single desktop from muliple displays and GPUs. Bezsl comection s avaiable to creste a seariess mage.
£ Display

Change resolution

‘Adjust desktop color settings

Rotate display

View HDCP status

Set up digital audio Create new confiquration
Set up multiple displays

) Video
Adjust video color settings
d

Identify displays.
] Wosscompiays- 1 Dbl
tate Topology ix2
Manage GPU Utilization Refresh Rate 60Hz
Resolution per display 1920 x 1080
Total resolution 3840 x 1080

[E] syncCapabiity Information

[@) sustem nformaton ‘ GPU/ Displays Sync capabilty
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Copyright © 2025 Xi'an NovaStar Tech Co., Ltd. All Rights Reserved.

No part of this document may be copied, reproduced, extracted or transmitted in any form or by any means
without the prior written consent of Xi'an NovaStar Tech Co., Ltd.

Trademark
NDV@)STAR is a trademark of Xi'an NovaStar Tech Co., Ltd.

Statement

Thank you for choosing NovaStar's product. This document is intended to help you understand and use the
product. For accuracy and reliability, NovaStar may make improvements and/or changes to this document at
any time and without notice. If you experience any problems in use or have any suggestions, please contact us
via the contact information given in this document. We will do our best to solve any issues, as well as evaluate
and implement any suggestions.

Official website
www.novastar.tech

Technical support
support@novastar.tech
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